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About This Guide

This guide introduces Novell® ZENworks® Virtual Machine Management, including its basic 
administration environment, which is accessed through an Eclipse* rich client console. This guide 
provides an introductory overview of Virtual Machine Management, and explains how to install, 
monitor, and manage VMs and coordinate their management with applications running on 
Orchestrator. For additional information about ZENworks and other Novell products, visit 
www.novell.com (http://www.novell.com/products/zenworks). 

The guide is organized as follows:

Chapter 1, “Overview,” on page 11
Chapter 2, “VM Management Setup and Tutorial,” on page 23
Chapter 3, “Creating Virtual Machines,” on page 39
Chapter 4, “Provisioning Virtual Machines,” on page 57
Chapter 5, “Deploying Virtual Machines,” on page 59
Chapter 6, “Ongoing Management of Virtual Machines,” on page 65
Chapter A, “Management Consoles for ZENworks VM Management,” on page 79
Appendix B, “VM Management Installation Sources,” on page 97
Appendix C, “Virtual Machine Technologies and Actions,” on page 99
Appendix D, “Sample VM Management Jobs,” on page 117

Audience

This book is for data center administrators, job managers, and job developers. It assumes that users 
of the product have the following background: 

General understanding of network operating environments and systems architecture
Knowledge of basic UNIX* shell commands, the Windows* command prompt, and text editors
General ZENworks Orchestrator Server knowledge

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html (http://
www.novell.com/documentation/feedback.html) and enter your comments there. 

Documentation Updates

For the most recent version of this guide, visit the ZENworks Orchestrator 1.3 documentation Web 
site (http://www.novell.com/documentation/zen_orchestrator13/). 
About This Guide 9
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Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux*, should use forward slashes as required by your software.
 ZENworks Orchestrator 1.3 Virtual Machine Management Guide
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1Overview

Novell® ZENworks® Virtual Machine Management (VM Management) adds increased 
functionality to Novell ZENworks Orchestrator. It helps administrators, IT operators, and job 
developers to improve and expand the performance and efficiency of the data center by automating 
provisioning and by using virtual machines (VMs) as resources in the data center computing 
environment. Better management of VMs assists in controlling associated data center costs by 
addressing several of the main data center issues, including cooling, space, power usage, and 
efficient hardware usage.

Review the following sections to get started with ZENworks VM Management:

Section 1.1, “How to Use This Guide,” on page 11
Section 1.2, “Virtual Machine Management,” on page 13
Section 1.3, “The Virtual Machine Life Cycle,” on page 15
Section 1.4, “Creating and Deploying Virtual Machines,” on page 15
Section 1.5, “Using Jobs for VM Management,” on page 17
Section 1.6, “Product Components,” on page 18

1.1  How to Use This Guide
This Overview section provides basic concepts about VM Management. The other main sections of 
the guide provide the following information:

Section 1.1.1, “Setup Tasks and Tutorial,” on page 11
Section 1.1.2, “VM Management Tasks,” on page 11
Section 1.1.3, “Appendixes,” on page 12

To continue with the basic concepts, see Section 1.2, “Virtual Machine Management,” on page 13.

1.1.1  Setup Tasks and Tutorial
To begin using VM Management, you must first perform some setup tasks as outlined in Chapter 2, 
“VM Management Setup and Tutorial,” on page 23.

This section also provides a first-run tutorial to familiarize you with the VM life cycle processes.

1.1.2  VM Management Tasks
Review the  following sections for information on the various Virtual Machine Management tasks:

Chapter 3, “Creating Virtual Machines,” on page 39

Provides information how to create and configure VMs. For example:
Launching the ZENworks VM Management Console
Building a VM
Overview 11
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Discovering VMs
Storing and versioning a VM

Chapter 4, “Provisioning Virtual Machines,” on page 57
Provides some information on provisioning VMs. Provisioning is usually done when VM jobs 
are run.
For more information on provisioning as it is related to VM jobs, see “Provisioning Virtual 
Machines” in the Novell ZENworks Orchestrator 1.3 Developer Guide and Reference.
Chapter 5, “Deploying Virtual Machines,” on page 59
Provides information you on how to deploy your VMs. You can deploy VMs to the following 
repositories:

Local
Datagrid
Warehouse
Network Attached Storage (NAS)
Storage Area Network (SAN)

Chapter 6, “Ongoing Management of Virtual Machines,” on page 65
Provides ongoing management tasks, such as:

Managing a VM in runtime
Modifying a VM after checking it in to the Warehouse
Monitoring VMs
Using a VM that is not checked in to the Warehouse
Using the Orchestrator User Portal to run VM jobs
Destroying a VM

1.1.3  Appendixes
The appendixes provide other information that you might need:

Appendix A, “Management Consoles for ZENworks VM Management,” on page 79

Provides information on the management consoles for doing your VM Management work.
Appendix B, “VM Management Installation Sources,” on page 97
Provides two sources from which to obtain software when building VMs.
Appendix C, “Virtual Machine Technologies and Actions,” on page 99
Provides information about the different ZENworks VM technologies, ZENworks Orchestrator 
provisioning adapters, and actions that you can perform to and with a VM.
Appendix D, “Sample VM Management Jobs,” on page 117
Provides an example job that is designed to help you to install the Orchestrator Agent on all 
VMs running Apache*.
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1.2  Virtual Machine Management
ZENworks Orchestrator enables you to manage and control data center jobs and processes through 
the application of rules, policies, scheduling, utilization, and billing data center resources. VM 
Management enhances the functionality of ZENworks Orchestrator Server, enabling it to control 
VMs in your data center.

The Orchestrator Server manages resources to perform work. It does this through automated jobs 
(written in Jython) that in turn are broken down into joblets that are distributed among multiple 
resources. For more information about ZENworks Orchestrator and Orchestrator Server operations, 
see “What You Should Know” in the Novell ZENworks Orchestrator 1.3 Developer Guide and 
Reference. 

With VM Management, the Orchestrator Server is able to control and maximize the use of VMs in 
your data center. This lets you have fewer physical machines while giving your data center many 
additional resources. As with your physical resources, you use the ZENworks Orchestrator Console 
to manage the physical VM host machines and their VMs in your data center.

In addition, as calls for resources lessen and resources are released, the Orchestrator Server 
evaluates the capabilities of the active resources (VM or physical machine) and keeps the best 
resource for the job. This might include any of the currently running VMs.
Overview 13
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The following figure shows how VM Management plugs in to the Orchestrator Server:

Figure 1-1   ZENworks VM Management Integration with ZENworks Orchestrator
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1.3  The Virtual Machine Life Cycle
Automating the management of VMs through all aspects of the VM life cycle provides the ability to 
use your physical resources in the most efficient and productive manner. You create VMs as needed, 
put them under version control, provision them as jobs require, and remove them from the system 
when they are no longer needed.

Figure 1-2   The VM Life Cycle

The VM life cycle is divided into two parts: configuration and deployment. Configuration is 
performed on a VM in the security of a development environment, which allows for creation, 
testing, and modification of the VM until you are ready to launch the VM into the production 
environment. Deployment is performed in the production environment and the changes take place in 
real time. As the administrator, you might do both the configuration and deployment tasks.

1.4  Creating and Deploying Virtual Machines
The following sections describe the functions involved in creating and deploying VMs:

Section 1.4.1, “Creating Virtual Machines,” on page 16
Section 1.4.2, “Deploying Virtual Machines,” on page 16
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1.4.1  Creating Virtual Machines
Configuring VMs includes creating, storing, editing, and versioning. These configurations are done 
in an environment removed from your production environment. These VMs do not affect your data 
center operations. The configurations are done to prepare the VM for data center launch. Any 
changes made after data center launch are done during the deployment phase of the life cycle.

Create: ZENworks Virtual Machine Builder (VM Builder) is used to create new Xen* VMs. 
You simply define the parameters of the VM you need and the VM is automatically created to 
your specifications. For more information on the VM Builder, see Section 1.6.2, “Virtual 
Machine Builder,” on page 20.
Discover: The Orchestrator Server discovers VMs that exist in your enterprise. In order to be 
available as a resource for jobs, the VM must have the ZENworks Orchestrator Agent installed 
on it. These can be VMs you have just created or VMs that you have already been using in your 
enterprise. For information on discovering VMs and VM host machines in ZENworks 
Orchestrator, see Section 1.6.5, “ZENworks Orchestrator Console Elements,” on page 21. For 
information on installing the Orchestrator Agent on a VM, see “Installing the Orchestrator 
Agent on VMs” in the Novell ZENworks Orchestrator 1.3 Installation and Getting Started 
Guide. 
Check-in: Both created and discovered VMs can be checked into the ZENworks Virtual 
Machine Warehouse. When VMs are checked in, version control is implemented. You can 
decide to not check VMs in so they do not receive version control. For more information on the 
VM Warehouse, see Section 1.6.3, “Virtual Machine Warehouse,” on page 21.
Edit: You can check VMs out from the VM Warehouse to edit their configuration or operating 
system image, then when you check an edited VM back into the VM Warehouse, it has its 
version number incremented. When you have two or more versions of a VM, the designation of 
Gold Master version is used to identify the approved version, which you can set to be any of its 
versions. The Gold Master version is the version of the VM that launches when deployed by 
the Orchestrator Server. There can be many Gold Master versions of VMs (but one per VM). 
These are listed in the ZENworks Orchestrator Console under the Repository and VM headings 
in the tree. For more information on editing VMs, see Section 6.3, “Modifying a Virtual 
Machine after Checking In,” on page 71.

1.4.2  Deploying Virtual Machines
When deploying VMs, you designate management of the VMs that are under version control, tested, 
and ready for deployment. These include further developmental changes to the VM, changes made 
because of Q/A testing, or changes required after launching the VM into your data center’s 
production environment.

Deploy: Deployment operations are performed through ZENworks Orchestrator. When a VM 
is ready for your production environment, you can list either a started VM or a VM Template as 
a resource. These VMs, as stated before, must have the Orchestrator Agent installed on them 
before they become resources.

The ZENworks Orchestrator deploys a VM when it is needed to run a job, in the same way as it 
uses physical machines to meet the resource needs of a job. When a VM template is deployed, 
the template is cloned into a VM and then deployed. The cloned VM is destroyed when the job 
releases it. For information on deploying VMs, see Chapter 5, “Deploying Virtual Machines,” 
on page 59.
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Monitor: The ZENworks Monitoring Service, which is included as another perspective with 
VM Management, monitors every aspect of your VMs, including their performance, status, and 
availability. This service also monitors the host machines on which your VMs are deployed and 
can be extended to any physical machine in your network.
Manage: While your VMs are deployed, you can manage any step of the life cycle of the VM 
according to your criteria. You can manage the process of cloning, the overall properties of the 
VM, and you can use provisioning adapters to manage the location of the VM within your VM 
Host environment. You can also patch deployed VMs or send them to a directory for image 
editing. If a VM Host fails or experiences performance issues, the Orchestrator Server transfers 
the active, running VM to another server with a barely perceptible pause in the speed and 
continuity of the transfer of data. For more information on managing your VMs in runtime, see 
Section 6.2, “Managing a Virtual Machine in Runtime,” on page 65.
Destroy: At the end of its usefulness, you can destroy the VM, which removes it from its 
listing in the ZENworks Orchestrator Console. To completely destroy the VM, you also need to 
delete its stored image in the VM Warehouse. For information on destroying VMs, see 
Section 6.1, “Destroying a Virtual Machine,” on page 65.

1.5  Using Jobs for VM Management
While ZENworks Orchestrator enables you you manage many aspects of your virtual environment, 
your job developer can create custom jobs that do the following VM Management tasks:

Create and clone VMs

These jobs create virtual machine images to be stored or deployed. They also create templates 
for building images to be stored or deployed.
Discover resources that can be used as VM hosts
Provision, migrate, and move VMs
Virtual machine images can be moved from one physical machine to another.
Check in VMs that have the proper versions and system configurations
Provide checkpoints, restoration, and resynchronization of VMs
Snapshots of the virtual machine image can be taken and used to restore the environment if 
needed.
Retire, delete, and destroy VMs
Jobs can decommission and retire deployed images.
Monitor VM operations
Jobs can start, shut down, suspend and restart VMs.
Manage on, off, suspend, and restart operations

For more information on creating VM Management jobs, see “Virtual Machine Job Development” 
in the Novell ZENworks Orchestrator 1.3 Developer Guide and Reference.
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1.6  Product Components
There are several new architectural components in VM Management that function with the 
ZENworks Orchestrator Server and the ZENworks Orchestrator Console. These elements give you 
additional functionality, including ZENworks Orchestrator Monitoring designed to function with the 
overall monitoring capabilities of the Orchestrator Server.

The list of architectural components includes the following:

Section 1.6.1, “Component Introduction for ZENworks VM Management,” on page 18
Section 1.6.2, “Virtual Machine Builder,” on page 20
Section 1.6.3, “Virtual Machine Warehouse,” on page 21
Section 1.6.4, “ZENworks Orchestrator Monitoring,” on page 21
Section 1.6.5, “ZENworks Orchestrator Console Elements,” on page 21

1.6.1  Component Introduction for ZENworks VM Management
The following are the additional components involved in making sure the managed VMs are able to 
function with the Orchestrator Server and help you in running your data center.

“SUSE Linux Enterprise Server Xen Server” on page 18
“The ZENworks Client and the ZENworks VM Management Console” on page 19
“The Orchestrator User Portal” on page 20
“Oracle Cluster File System 2” on page 20
“ZENworks Orchestrator” on page 20
“ZENworks Virtual Machine Builder” on page 20
“ZENworks Virtual Machine Warehouse” on page 20

SUSE Linux Enterprise Server Xen Server

The SUSE® Linux Enterprise Server (SLES) Xen Server is a robust, production-proven 
virtualization layer run on physical servers, It abstracts processor, memory, storage, and networking 
resources into multiple VMs.

The basic components of a virtualization environment based on Xen are the Xen hypervisor, the VM 
host machine, any number of other guest operating system VMs based on Xen, and the tools, 
commands, and configuration files that let you manage virtualization. Collectively, the physical 
computer running all these components is referred to as a virtualization host server because these 
components form a platform for hosting VMs.

“The Xen Hypervisor” on page 19
“The VM Host Machine” on page 19
“Virtual Machines Based on Xen” on page 19
“Management Tools, Commands, and Configuration Files” on page 19
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The Xen Hypervisor

The Xen hypervisor, sometimes referred to generically as the hypervisor or VM monitor, is an open 
source software program that coordinates the low-level interaction between VMs and physical 
hardware.

For further information on the Xen hypervisor that is shipped with SLES 10 SP1, see Introduction to 
Xen Virtualization (http://www.novell.com/documentation/vmserver/virtualization_basics/data/
b9km2i6.html#b9km2i6) in the Novell Virtualization Technology: Virtualization Technology Guide.

The VM Host Machine

The management VM has the Xen hypervisor directly installed on the hardware and serves as the 
hardware abstraction layer. The host operating system runs in the Host Xen domain in the first layer 
of the hypervisor. VMs can only be installed and run in the Host. The host machine is comprised of 
several components, such as:

The SUSE Linux operating system, which gives the administrator a graphical desktop and 
command line environment to manage the virtualization host server components and its VMs.
The xend daemon, which stores configuration information about each VM and controls how 
VMs are created and managed.
A modified version of QEMU, which is an open source software program that emulates a full 
computer system, including a processor and various peripherals. It provides the ability to host 
operating systems in full virtualization mode.

Virtual Machines Based on Xen

A VM based on Xen is a guest, and runs the guest operating system. Guests can only run on the Host 
and cannot run another VM. VMs based on Xen consist of the following components:

At least one virtual disk that contains a bootable operating system
VM configuration information, which is managed by the xend daemon and can be modified 
by modifying a text file

Management Tools, Commands, and Configuration Files

You use a combination of GUI tools, commands, and configuration files to help you manage and 
customize your virtualization environment.

The ZENworks Client and the ZENworks VM Management Console

These tools are consoles that allow users to connect to the Orchestrator Server or individual Xen 
VM host machines from a SUSE Linux Enterprise Desktop (SLED) 10 SP1 remote machine. The 
ZENworks VM Management Console is an Eclipse*-based rich-client environment that allows you 
to use the VM Builder, VM Warehouse, and ZENworks Orchestrator Monitoring. For more 
information on the ZENworks VM Management Console, see Section A.2, “The ZENworks VM 
Management Console,” on page 84.
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The Orchestrator User Portal

The ZENworks Orchestrator User Portal is used to connect to a Web location to allow the user to run 
a job. The jobs and available resources are assigned to the user by the Orchestrator administrator. 
For information about the Orchestrator User Portal, see “Using the ZENworks Orchestrator User 
Portal” in the Novell ZENworks Orchestrator 1.3 Job Management Guide. 

Oracle Cluster File System 2

Oracle* Cluster File System 2 (OCFS2) is a high-performance cluster file system for Xen Server 
VMs. It is a general-purpose journaling file system that is fully integrated in the Linux kernel 2.6 
and later. OCFS2 allows you to store application binary files, data files, and databases on devices in 
a SAN. All nodes in a cluster have concurrent read and write access to the file system. A distributed 
lock manager helps prevent file access conflicts. OCFS2 supports up to 32,000 subdirectories and 
millions of files in each directory. The O2CB cluster service (a driver) runs on each node to manage 
the cluster.

ZENworks Orchestrator

ZENworks Orchestrator dynamically allocates and balances computing across collections of 
resources. VM Management functions as an expansion of available services to ZENworks 
Orchestrator to allow ZENworks Orchestrator to manage physical and VMs. For more information 
on ZENworks Orchestrator, see the “Introduction” section in the Novell ZENworks Orchestrator 1.3 
Installation and Getting Started Guide. 

ZENworks Virtual Machine Builder

The ZENworks Virtual Machine Builder (VM Builder) provides the ability to create and build a VM 
on a variety of different servers as designated by the physical capabilities of the machines in your 
VM Builder group. For more information on the VM Builder, see Section 1.6.2, “Virtual Machine 
Builder,” on page 20.

ZENworks Virtual Machine Warehouse

The ZENworks Virtual Machine Warehouse (VM Warehouse) stores and versions VMs as they are 
checked in. These VMs can be checked back out, edited and modified, and then be checked back in 
to increment the next version number.

1.6.2  Virtual Machine Builder
The ZENworks VM Builder is a service of VM Management that allows you to build a VM to 
precise specifications required for your data center. You designate the parameters required: 
processor, memory, hard drive space, operating system, virtualization type, if it’s based of an auto-
install file, and any additional parameters.

When you launch the build job, VM Builder sends the build request to a machine that meets the 
hardware requirements of the defined VM and builds the VM there.

These VMs are built using the Xen hypervisor through the VM Builder Wizard in the ZENworks 
VM Management Console.
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ZENworks Orchestrator 1.3 Xen VMs can be fully virtualized or, for SLES 10 and Red Hat* 
Enterprise Linux (RHEL) 5, they can be paravirtualized. For details on building VMs and the 
functionality of the VM Builder, see Section 3.2, “Building a Virtual Machine,” on page 42.

1.6.3  Virtual Machine Warehouse
The VM Warehouse contains the VMs you have created and discovered. When you check a VM into 
the VM Warehouse, it is brought under version control. Any time you make modifications to the 
VM, in a development, testing, or production environments, you can check these modified versions 
back into the VM Warehouse to have the VM assigned the next version number.

When you have built and tested sufficient VM versions, and a VM version has been certified for 
deployment in your production environment, you can designate that version as the Gold Master. 
From that point forward, any time you deploy an instance of that VM through the Orchestrator 
Server, the Gold Master deploys. You can change the Gold Master designation at any time inside the 
VM Warehouse. For more information on operating the VM Warehouse, see Section 3.3, “Storing 
and Versioning a Virtual Machine,” on page 53.

1.6.4  ZENworks Orchestrator Monitoring
The ZENworks VM Management Console gives an additional Monitoring perspective for 
ZENworks Orchestrator Monitoring. This perspective gives you the ability to get a Web-based 
report on any of your VMs, VM hosts, and all other managed nodes (including physical machines). 
In order to be monitored, the ZENworks Monitoring Agent must be installed. For more details about 
what can be monitored and how to monitor with the Monitoring Server, see Section 6.4, 
“Monitoring Virtual Machines,” on page 74. 

1.6.5  ZENworks Orchestrator Console Elements
The ZENworks VM Management Console helps you make the best use of your VMs in the data 
center. VM Management works with the Orchestrator Server, and it contains many elements 
necessary to manage your VMs. You can use the ZENworks Orchestrator Console to tell the 
Orchestrator Server to detect and list your VM host machines, pre-existing VMs, and the Gold 
Master versions. The list of VMs appears in the Repository section of the ZENworks Orchestrator 
Console allows you to select specific VMs (Gold Master versions) to be deployed to host machines. 
For details on managing your VMs with the ZENworks Orchestrator Console, see Section A.1, “The 
ZENworks Orchestrator Console,” on page 80.

“Discovering Virtual Machine Hosts” on page 21
“Discovering Virtual Machine Images” on page 22
“Using the ZENworks Orchestrator Console to Deploy Virtual Machines” on page 22

Discovering Virtual Machine Hosts

When you first start the ZENworks Orchestrator Console, it lists no VMs and no VM hosts. When 
you click Provision > Discover VM Hosts, the ZENworks Orchestrator Console searches through all 
ZENworks Orchestrator Server provisioning adapters and finds all the VM hosts in your data center 
that you have chosen to register with the Orchestrator Server. These are listed under the VM Hosts 
section of your tree in ZENworks Orchestrator Console. For detailed instructions on discovering 
VM hosts, see Section 2.2.4, “Discovering Virtual Machine Hosts,” on page 30. 
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Discovering Virtual Machine Images

In the ZENworks Orchestrator Console, click Provision > Discover VM Images to have the 
Orchestrator Server find any VMs in your data center and VMs with the Orchestrator Agent 
installed. This action also lists (in the Repository section) all VM Images available to the 
Orchestrator Server. For detailed instructions on discovering VM images, see Section 3.1, 
“Discovering Existing Virtual Machines,” on page 39. 

Using the ZENworks Orchestrator Console to Deploy Virtual Machines

In order for joblets and jobs to be deployed to the VMs, the Orchestrator Agent must be installed as 
an application on the VM. VMs that have been started and are running the Orchestrator Agent are 
listed as available resources for ZENworks Orchestrator to use in the Repositories and Resources 
sections in the ZENworks Orchestrator Console. These VMs are made available by moving them 
into the Resources list. You can move VM templates that haven’t been started into the Resources list 
to make clones of the templates available as resources. As the Orchestrator Server requires a server 
meeting the requirements of the VM Template, it clones and launches a VM of that type. For more 
information on deploying VMs in the ZENworks Orchestrator Console, see Chapter 5, “Deploying 
Virtual Machines,” on page 59. 
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2VM Management Setup and 
Tutorial

The first time you run the Novell® ZENworks® Orchestrator Console and the ZENworks VM 
Management Console, there are actions you need to take to make sure your VMs are enabled for use 
in your data center. After these actions are taken, you can begin using the VM Builder and VM 
Warehouse features to create and deploy VMs.

Perform the following tasks to set up VM Management and do a first run to familiarize you with the 
VM life cycle:

Section 2.1, “Installing or Upgrading the VM Management Software,” on page 23
Section 2.2, “Setting Up VM Management with the ZENworks Orchestrator Console,” on 
page 23
Section 2.3, “First Run Tutorial,” on page 31
Section 2.4, “What’s Next?,” on page 37

2.1  Installing or Upgrading the VM Management 
Software
VM Management is installed separately from ZENworks Orchestrator. A VM Management 
installation consists of installing the ZENworks VM Management Console on your Linux or 
Windows administration devices.

For instructions on installing VM Management, see “Installing the VM Management Console” in 
the Novell ZENworks Orchestrator 1.3 Installation and Getting Started Guide.

To upgrade VM Management, simply replace the previous version of the console by installing the 
newer version’s ZENworks VM Management Console.

Continue with Section 2.2, “Setting Up VM Management with the ZENworks Orchestrator 
Console,” on page 23.

2.2  Setting Up VM Management with the 
ZENworks Orchestrator Console
Before you can use the ZENworks VM Management Console, you need to:

Install and configure the Orchestrator Server and its components

For instructions, see “Installing and Configuring ZENworks Orchestrator Components” in the 
Novell ZENworks Orchestrator 1.3 Installation and Getting Started Guide.
Make sure that your VM host machines and your VM Builder machines are recognized
Make sure that your main physical resources are registered
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To accomplish the latter two points, complete the following tasks in order:

1. “Discovering Physical Resources” on page 24
2. “Resuming the VNC Password Job” on page 26
3. (Optional) “Setting Joblet Slots on Physical Machines” on page 28
4. “Discovering Virtual Machine Hosts” on page 30

2.2.1  Discovering Physical Resources
After you have configured and set up your Orchestrator Server:

1 Open the ZENworks Orchestrator Console.
The console is displayed with the available grids displayed:

2 Click your grid in the tree view.
The Login dialog box is displayed:

3 Enter your administrator username and password.
The console is displayed with the information expanded for the selected grid:
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4 Click the Resources button to display the Resources tab:

5 Click the mailbox ( ) in the upper left of the Resources view to open the following dialog box:

6 Select Accept to register the physical resources available, then click OK to display the available 
resources:
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After your physical resources are registered, you can begin to build and discover the VM hosts 
and VMs in your data center, which brings the VMs into the control of the Orchestrator Server 
and allows you to install the Orchestrator Agent on any VMs that are already installed on your 
system. After the VM host machines have been discovered, you can also begin the process of 
creating VMs.
For information on creating VMs, see Section 3.2, “Building a Virtual Machine,” on page 42 
and for information on discovering VMs, see Section 3.1, “Discovering Existing Virtual 
Machines,” on page 39.

7 Continue with Section 2.2.2, “Resuming the VNC Password Job,” on page 26.

2.2.2  Resuming the VNC Password Job
The VNC password was set when you ran the configuration script. The vmHostVncConfig job must 
be activated because it is shipped in a paused state. This job opens up the VNC port on the VM host 
machines that are part of the VM Builder group in the Orchestrator Server and sets the previously 
specified password.

When this job is running it allows you to open a VNC session to the ZENworks VM Management 
Console or any other VNC client.

To resume the VNC job:

1 In the ZENworks Orchestrator Console, click the Scheduler button.
The applicable portion of the console is illustrated here:
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2 Select the vmHostVncConfig job (indicated in blue):

3 Click Enable, then click Run Now:
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4 Continue with one of the following:
(Optional) Section 2.2.3, “Setting Joblet Slots on Physical Machines,” on page 28
Section 2.2.4, “Discovering Virtual Machine Hosts,” on page 30

2.2.3  Setting Joblet Slots on Physical Machines
If your physical machine is going to be part of the group of Xen hypervisor-enabled machines that 
you want to use as VM Builder agent machines, you might want to increase the number of joblet 
slots on that particular physical machine. 

To set joblet slot values:

1 In the ZENworks Orchestrator Console, select a physical resource in the left pane, then in the 
right pane, click the Info/Groups tab:
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If necessary, click the  icon to open the Info section.
2 Scroll down to view the Joblets Slot field:

3 In the Joblet Slots field, change the default of 1 to a higher value (depending on the capacity of 
the machine), then click File > Save to make the change effective.
Two or three slots is the recommended number of joblet slots for most machines.
Additional joblet slots allows you to run multiple joblets on the machine, or build more than 
one VM at a time.
VM Management Setup and Tutorial 29



30 Novell

novdocx (en)  11 July 2008
You can also make this change on non-VM Builder servers.
4 Continue with Section 2.2.4, “Discovering Virtual Machine Hosts,” on page 30.

2.2.4  Discovering Virtual Machine Hosts
After you have discovered your physical resources, resumed the VNC job, and have set the correct 
number of joblet slots for the VM Builder host and other VM host machines, you can begin to 
discover and build VMs in your data center. For information on using the VM Builder to build your 
new VMs, see Section 3.2, “Building a Virtual Machine,” on page 42. For information on 
discovering VMs in your data center, see Section 3.1, “Discovering Existing Virtual Machines,” on 
page 39.

When you load ZENworks Orchestrator Console with active VM Management, you can use the 
console to manage VMs as resources in your data center. Before you can use your VMs, you need to 
discover the machines on which they reside and on which they will run.

1 In the ZENworks Orchestrator Console, click Provision > Discover VM Hosts to display the 
Discover VM Hosts dialog box.

2 Select your provisioning adapter (vcenter, vmserver, or xen30) from the drop-down menu.

IMPORTANT: In order to use Xen 3.0 virtual machines, select xen30.

For information on provisioning adapters, see Chapter 4, “Provisioning Virtual Machines,” on 
page 57.

3 Click OK.
The following dialog box is displayed:

4 Click Jobs to view the Jobs section in the ZENworks Orchestrator Console and verify that the 
job has started.
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After your VM host machines are discovered, you can refresh your tree view or wait for the 
automatic tree refresh to see the VM host machine listed under the provisioning adapter, 
although no VMs are listed.
For a listing of the VM technologies and supported host and guest operating systems, see 
Section C.1, “Virtual Machine Technologies,” on page 99.

5 Continue with Section 2.3, “First Run Tutorial,” on page 31.

2.3  First Run Tutorial
The following provides a tutorial to familiarize you with the VM life cycle processes:

Section 2.3.1, “Starting the ZENworks Orchestrator Management Environment,” on page 32
Section 2.3.2, “Providing an Installation Source for installing a New Virtual Machine,” on 
page 32
Section 2.3.3, “Creating a New Virtual Machine,” on page 32
Section 2.3.4, “Installing the Orchestrator Agent on the Virtual Machine,” on page 33
Section 2.3.5, “Installing Applications on the Virtual Machine,” on page 34
Section 2.3.6, “Checking the Virtual Machine in to the VM Warehouse,” on page 34
Section 2.3.7, “Provisioning the Virtual Machine,” on page 34
Section 2.3.8, “Deploying the Virtual Machine,” on page 34
Section 2.3.9, “Cloning the Virtual Machine,” on page 35
Section 2.3.10, “Monitoring Your Virtual Machines,” on page 36
Section 2.3.11, “Destroying the Virtual Machine,” on page 36
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2.3.1  Starting the ZENworks Orchestrator Management 
Environment

1 Make sure that the ZENworks Orchestrator Server is running.
For information, see “Installation and Configuration” in the Novell ZENworks Orchestrator 1.3 
Installation and Getting Started Guide.

2 (Conditional) Install both management consoles on your management workstation, if they have 
not yet been installed:

ZENworks Orchestrator Console: “Independent Installation of the Agent and Clients”
ZENworks VM Management Console: “Installing the VM Management Console”

Your management workstation can be running either Windows or Linux. Both consoles are 
available on these operating systems.

3 On your management workstation, open the ZENworks Orchestrator Console by using the 
instructions contained in Section A.1.1, “Launching the ZENworks Orchestrator Console,” on 
page 80.

4 Right-click the grid that you created during installation of ZENworks Orchestrator, select 
Login, then provide your username and password for the grid.

5 On your management workstation, open the ZENworks VM Management Console using the 
instructions contained in Section A.2.1, “Launching the ZENworks VM Management 
Console,” on page 84.

6 Continue with Section 2.3.2, “Providing an Installation Source for installing a New Virtual 
Machine,” on page 32.

2.3.2  Providing an Installation Source for installing a New 
Virtual Machine
To create a new VM, you’ll need an installation source for the VM’s operating system installation.

1 To select a VM installation source, see Appendix B, “VM Management Installation Sources,” 
on page 97.

2 Select a source that contains the necessary software for installing an operating system to the 
VM.
You might need to provide the software in your selected source. Select an operating system that 
you’ll likely use in your production environment, perferably one that won’t require a lot of 
configuration, which is done in the next section when you create the VM.

3 Continue with Section 2.3.3, “Creating a New Virtual Machine,” on page 32.

2.3.3  Creating a New Virtual Machine
1 In the ZENworks VM Management Console, do one of the following actions to open the VM 

Builder Wizard:
Click the Create New button ( ) on the toolbar.
Click File > Create New.
Right-click in the Workspace panel and select Create New:
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Double-click a blank space in the Workspace panel.
2 In the VM Build Wizard, fill in the necessary information on the wizard pages to define your 

VM, then click Install on any wizard page when finished configuring the VM.
For details on the wizard pages, see:

Description page: “Description” on page 44
Hardware page: “Hardware” on page 45
Storage Devices page: “Storage Devices” on page 46
Network page: “Network” on page 47

If you click Apply, the wizard exits without starting the installation of the VM. Instead, the VM 
is listed in the Workspace panel as Defined. To start the installation from there, simply right-
click the VM name and select Install.
For other ways to start a defined VM’s installation, see Section 3.2.3, “Installing a Defined 
Virtual Machine,” on page 49.
You can also edit an installed VM, but cannot edit as many fields as you can before the VM is 
installed. The Edit option allows you to edit a defined VM, and the Edit Image option allows 
you to create a copy of the VM that is put elsewhere on the drive, so you can open the VM 
Image and change its inherent metadata, processor architecture, initial hard disk properties, 
memory properties, and so forth. For more information, see Section 6.3.2, “Modifying Virtual 
Machine Properties,” on page 71.

3 To monitor the installation process, do both of the following:
In the ZENworks VM Management Console, click Window > Show View > Progress to 
display the Progress panel.
In the ZENworks Orchestrator Console, click the Jobs tab.

4 To interact with the VM where the software is being installed, click the Show VNC icon ( ) 
and provide your VNC password.

5 After the VM has been installed, continue with one of the following:
Section 2.3.4, “Installing the Orchestrator Agent on the Virtual Machine,” on page 33
Section 2.3.5, “Installing Applications on the Virtual Machine,” on page 34

2.3.4  Installing the Orchestrator Agent on the Virtual Machine
If you want a VM to be used by the Orchestrator Server as a resource for high performance 
computing (HPC), you must install the Orchestrator Agent.

1 Follow the instructions contained in “Installing the Orchestrator Agent on VMs” in the Novell 
ZENworks Orchestrator 1.3 Installation and Getting Started Guide.

2 Continue with Section 2.3.5, “Installing Applications on the Virtual Machine,” on page 34.
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2.3.5  Installing Applications on the Virtual Machine
To understand how to enhance the functionality of a VM that might be a basic operating system 
installation, install some applications on the VM. Choose the applications for a simple purpose so 
you can see whether the VM is behaving as desired after it has been deployed.

Do the following:

1 Start the VM on a VM Host outside of your production environment.
The VM can be left running after its installation if it is installed on a VM Host outside of your 
production environment. 

2 Install a few selected applications on the running VM.
Do this by installing the software just as you would on a physical machine.

3 After you have installed the applications, stop the VM.
The applications remain installed the next time you start the VM.

4 Continue with Section 2.3.3, “Creating a New Virtual Machine,” on page 32.

2.3.6  Checking the Virtual Machine in to the VM Warehouse
In order for the VM to be used, it must be checked in to the VM Warehouse.

1 In the ZENworks VM Management Console, do one of the following:
Right-click the VM and select Check In. 
Select the VM, then click File > Check In. 
Select the VM and click the Check In button. 

2 To view the VM in the VM Warehouse, double-click a warehoused VM, or right-click the VM 
in the warehouse and select Show Versions.
This displays a list of all the versions of that VM in an edit window on the right.

3 Continue with Section 2.3.7, “Provisioning the Virtual Machine,” on page 34.

2.3.7  Provisioning the Virtual Machine
Provisioning is used to get a VM ready to start in a running state when deployed. For more 
information, see Chapter 4, “Provisioning Virtual Machines,” on page 57.

For procedures and more information on provisioning of VMs, see “Virtual Machine Job 
Development” in the Novell ZENworks Orchestrator 1.3 Developer Guide and Reference.

Continue with Section 2.3.8, “Deploying the Virtual Machine,” on page 34.

2.3.8  Deploying the Virtual Machine
By default, the Xen and VMware server adapters create a local type Repository object for local VM 
images when ZENworks Orchestrator accomplishes the Discover VM Hosts action.

For information on other deployment resources, see Chapter 5, “Deploying Virtual Machines,” on 
page 59.
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To deploy the VM:

1 In the ZENworks Orchestrator Console, create a job that deploys the VM to a VM Host where 
the VM can be used for a particular purpose of your choosing.
For information on creating deployment jobs, see Novell ZENworks Orchestrator 1.3 
Developer Guide and Reference.

2 To deploy the job, go to the ZENworks Orchestrator Console, click Actions > Deploy Job, then 
select the VM job that you created in Step 1.

3 Monitor the VM to see whether it is deployed and is working as designed.
4 Continue with Section 2.3.9, “Cloning the Virtual Machine,” on page 35.

2.3.9  Cloning the Virtual Machine
A VM template is a special kind of VM that is not deployed separately. When the Orchestrator 
Server needs a VM of the template’s type to be used as a resource, it automatically clones a version 
of the VM and uses that clone as the VM. You can change cloned VMs into instances of VMs 
instead of clones.

1 To make a VM instance into a template, go to the ZENworks Orchestrator Console, right-click 
the VM, then select Create Template.

2 Do the following:
Name the template.
Specify a repository.
Specify a visible VM host.
Select a recommended host for the VMs to be launched on, if any are present.

3 Click OK when finished defining the template.
When the clone of the template VM is provisioned, it appears as a sub-branch of the template’s 
location in the resources tree, as in the following Linux and Windows examples:
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This clone functions as an instance of a VM and runs as though it were its own version with its 
own MAC address and other unique identifiers. The UUID is the only new information that is 
automatically generated for the clone. All the rest of the new information comes from autoprep, 
including the MAC address if an asterisk (*) is placed in the Mac Address field in the Autoprep 
Network Adapter section of the Info/Groups tab for the template (the default is a blank field, 
meaning no MAC address is created), and if the Use Autoprep check box is enabled on the 
Create VM from Template dialog box.
When the Orchestrator Server no longer needs the clone, it deprovisions it and automatically 
deletes it from the data center.

4 If you decide to keep a clone VM, go to the ZENworks Orchestrator Console, right-click the 
clone and select Remove Template Dependency.
This brings up the Remove Template Dependency dialog box, shown in the following figure:

5 Click OK to retain the clone VM.
6 Continue with Section 2.3.10, “Monitoring Your Virtual Machines,” on page 36.

2.3.10  Monitoring Your Virtual Machines
You can monitor your virtual machines from both management consoles.

1 Use the ZENworks VM Management Console to view your VMs.
This console can be used to influence decisions about machines to constrain to use specific 
joblets and be hosts to specific VMs. You can view the VM information in a text or graphical 
view.
For information, see Section 6.4.1, “Using the ZENworks VM Management Console 
Monitoring View,” on page 75.

2 Use the ZENworks Orchestrator Console to view your VMs.
This console allows you to view the information by looking at the Jobs section, which provides 
feedback for jobs being executed by the Orchestrator Server.
For information on monitoring from the ZENworks Orchestrator Console, see Section 6.4.2, 
“Monitoring Orchestrator Server Jobs,” on page 77.

3 Continue with Section 2.3.11, “Destroying the Virtual Machine,” on page 36.

2.3.11  Destroying the Virtual Machine
When you want ZENworks Orchestrator to no longer use a VM, you can “destroy” it.

1 In the ZENworks Orchestrator Console, right-click the VM in the tree and select Delete/
Destroy Resource.
This action removes the VM from your resource list. However, the actual image of the VM is 
still stored in its directory. If the VM was stored in the VM Warehouse, it is retained there.
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2 (Optional) If you deleted a VM from your resource tree, rediscover it by running a discovery 
job. Click Provision > Discover VM Images to rediscover any VMs in your data center with 
unique UUIDs.

3 To delete a VM from the VM Warehouse, right-click the VM in the ZENworks VM 
Management Console and select Delete.
This completely deletes the VM and all its versions from your data center. You cannot restore 
any version of the VM after you delete it from the Warehouse. However, if you do have a 
checked-out instance of the VM, you can check that back into the Warehouse.

4 Continue with Section 2.4, “What’s Next?,” on page 37.

2.4  What’s Next?
After you have logged in to the ZENworks VM Management Console, you can begin to build VMs 
by using the VM Builder, check those VMs into the warehouse, check out and modify the VMs, and 
use the ZENworks VM Management Console to its full capacity as an efficient resource in 
managing your VMs.

To perform VM Management tasks, continue with:

Chapter 3, “Creating Virtual Machines,” on page 39
Chapter 4, “Provisioning Virtual Machines,” on page 57
Chapter 5, “Deploying Virtual Machines,” on page 59
Chapter 6, “Ongoing Management of Virtual Machines,” on page 65

For more information on the ZENworks VM Management Console, see Chapter A, “Management 
Consoles for ZENworks VM Management,” on page 79.
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3Creating Virtual Machines

In creating virtual machines (VMs), you design, build, and test your VMs before deploying them to 
your data center. The Novell® ZENworks® VM Management Console aids you in developing and 
testing your VMs before listing them as deployable resources in your ZENworks Orchestrator 
Console. These actions do not directly impact your production environment.

Review the following sections to discover, design, build, install, configure with applications, store, 
and version your VMs:

Section 3.1, “Discovering Existing Virtual Machines,” on page 39
Section 3.2, “Building a Virtual Machine,” on page 42
Section 3.3, “Storing and Versioning a Virtual Machine,” on page 53

3.1  Discovering Existing Virtual Machines
You can use VMs you have previously created or VMs you have built by using other hypervisors in 
your data center. To make use of these VMs, you need to run a discover job. You use the ZENworks 
Orchestrator Console to detect the VMware Server, VMware Virtual Center, and Xen VM host 
machines.

After you have detected the host machines, you can detect the VMs contained on the host machines 
and in other VM storage repositories. This search seeks VMs stored already on the host machines 
and any Gold Master versions of the VMs stored in the VM Warehouse. This discovery process 
applies to Xen, VMware Server, and VMware Virtual Center VMs.

NOTE: The following steps assume that you have already discovered and incorporated all physical 
resources of the data center, including the host machine (which lists as a physical resource). If you 
have not done this, see Section 2.2.1, “Discovering Physical Resources,” on page 24. For 
information on discovering VM host machines, see Section 2.2.4, “Discovering Virtual Machine 
Hosts,” on page 30.

To discover VMs in the entire data center:

1 In the ZENworks Orchestrator Console, click Provision > Discover VM Images.
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2 Select the provisioning adapter.

For information on provisioning adapters, see Chapter 4, “Provisioning Virtual Machines,” on 
page 57.

3 Select the source repository or repositories.
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4 Click Add to add the source repository to the target repository list.
5 Click OK when you are finished adding source repositories.
6 Look at the Jobs view in the ZENworks Orchestrator Console to verify that the job to add 

source repositories has started.

When you discover VMs, they are listed both under their specific VM technology and under the 
VMs section in the ZENworks VM Management Console, as shown in the following figure:

Figure 3-1   Resource Tree with VMs in Explorer Window of the ZENworks Orchestrator Console
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3.2  Building a Virtual Machine
VM Builder is used to define the components required in a VM. When these components are 
defined, a request is sent to the Orchestrator Server which in turn sends the request to a VM host 
machine that is part of the VM Builder group.

When a VM Builder installation request is made, it is sent to the Orchestrator Server, which sends 
the request to a build machine. If a machine that meets the build requirements of the VM is found, 
then the Orchestrator Server launches the build job on that machine. You should not build a machine 
that exceeds the capability of the build machines in your VM Builder group.

For more information on the Orchestrator Server and its installed components, see “Software 
Architecture” in the Novell ZENworks Orchestrator 1.3 Installation and Getting Started Guide.

Do the following tasks in order:

Section 3.2.1, “Launching the Virtual Machine Builder,” on page 42
Section 3.2.2, “Defining the Virtual Machine,” on page 42
Section 3.2.3, “Installing a Defined Virtual Machine,” on page 49
Section 3.2.4, “Installing the Orchestrator Agent on a Virtual Machine,” on page 52
Section 3.2.5, “Installing Applications on a Virtual Machine,” on page 53
Section 3.2.6, “Checking a Virtual Machine into the VM Warehouse,” on page 53

3.2.1  Launching the Virtual Machine Builder
One of the functions provided by the ZENworks VM Management Console is the Virtual Machine 
Builder (VM Builder) Wizard. To launch the VM Builder Wizard:

1 In the ZENworks VM Management Console, do one of the following actions to open the VM 
Builder Wizard:

Click the Create New button ( ) on the toolbar.
Click File > Create New.
Right-click in the Workspace panel and select Create New:

Double-click a blank space in the Workspace panel.
2 Continue with Section 3.2.2, “Defining the Virtual Machine,” on page 42.

3.2.2  Defining the Virtual Machine
The VM Builder Wizard has four pages. As you progress through the pages, you can refer to this 
documentation or you can use the dynamic help displayed in the white bar at the top of the Wizard.
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To define a VM:

1 In the VM Build Wizard, fill in the necessary information on the wizard pages to define your 
VM.
Review the following sections for information on the wizard pages:

“Description” on page 44
“Hardware” on page 45
“Storage Devices” on page 46
“Network” on page 47

Click Back to make changes on any wizard page.
2 When you have completed defining the VM in the VM Builder Wizard, do one of the following 

to exit the wizard:
Click Apply on any wizard page, which saves your changes.
The defined VM is listed in the Workspace panel as Defined, which means it is not yet 
installed. To install the VM at a later time, review Section 3.2.3, “Installing a Defined 
Virtual Machine,” on page 49.
To install immediately, click Install on any wizard page, then continue with Section 3.2.3, 
“Installing a Defined Virtual Machine,” on page 49.
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Description

The following figure shows the VM Builder Wizard window when you first launch VM Builder:

Figure 3-2   VM Builder Wizard

The Description page is used to define the VM’s descriptive parameters and operating system:

VM Name: (Required) Give the VM a unique name. This name applies to all versions of the 
VM.
Description: Note the purpose and any other specifics you might require of the VM. These 
notes apply to all versions of this VM.
Guest Operating System: The operating system you want to install on your VM.
Virtualization Mode: Full Virtualization means that all the hardware components are 
emulated by the hypervisor. Paravirtualization means that the operating system directly 
accesses elements of the hardware, including processor, display, memory, network interface 
card, and hard drive, and uses the hypervisor to emulate other hardware interactions. 
Paravirtualization performs much faster and with better hardware efficiency than full 
virtualization. 

NOTE: Please refer to the SLES and RHEL documentation to verify supported platforms in 
each virtualization mode.
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Architecture: The type of processor you want to have as the virtual processor for the VM.
Install Source: (Required) The path to the installation media for your guest operating system. 
For a fully virtualized VM, the install source must be an ISO. For a paravirtualized VM, an ISO 
or network install source is required. For more information, see Appendix B, “VM 
Management Installation Sources,” on page 97.
Auto Install File: This field applies only to paravirtual installations. The file listed here is used 
to populate the answers needed during the installation of the guest operating system (some 
examples include time zone, language, firewall, and other settings given in response to the user 
interactive areas of the installation). An AutoYaST file listed here can contain network settings 
that are applied during the VM Builder job. For RHEL the file would be a kickstart file.
Additional Arguments: This field applies only to paravirtual installations. These are Linux 
install arguments, which are operating system parameters similar to the information entered in 
a GRUB boot loader when running on bare hardware in SLES and SLED. Additional network 
installation information can be added here, which will be used during the build process to find 
the installation source for the VM Build process.

Hardware

The hardware section defines the kind of actual hardware to be virtualized for the VM. The 
following graphic displays the Hardware page.

Figure 3-3   VM Builder Hardware Properties
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These hardware constraints are:

Virtual Processors: The number of virtual processors the VM has.
Processor Weight: The priority of the selected virtual processor over other virtual processors 
on the same VM host.
Memory Size: The amount of virtual RAM the VM has, or paravirtualized memory that can be 
used by the VM if it is paravirtualized.
Display: The properties of the VM’s display. If you have chosen paravirtualization for this 
VM, your only option is Paravirtualized. If you have chosen full virtualization, you can select 
between VESA or the on-board VGA. If you do not need a display, you can turn off the display 
on a fully virtualized machine. 

Storage Devices

The storage devices are the hard drives and CD or DVD drives you want to include in the VM 
profile. The first device must always be a hard disk that cannot be removed unless another hard disk 
has been put into the first slot. This is the only disk (Disk 0) that is stored and version controlled. All 
other disks added are virtual and are created upon the launch of the VM. You can add any other 
storage devices you want to the VM and move them according to priority in the list. The following 
figure shows the Storage Devices page. 

Figure 3-4   VM Builder Storage Device Definition
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The elements of the Storage Device Definition page are:

Add, Move, and Delete Control Buttons: These buttons control disk order beyond the initial 
required hard disk in the VM. The first disk must be a hard disk and is the only one that is 
actually stored in the VM image.
Name: The name is the number in the order the drive appears in its VM image listing.
Type: Select either Add CD-ROM or Add Hard Disk. Selecting Add CD-ROM allows you to 
add a CD-ROM or DVD ROM to your VM. Selecting Add Hard Disk allows you to add an 
additional hard disk to your VM. 
Source: The storage location of the hard disk of the VM.
Size (GB): The VM size, ranging from 0.25 GB (250 MB) to 4 TB. This is the maximum 
allowable size of the VM.
Sparse Image File: Select this option to make the file sparse. This makes the whole image file 
capable of taking up its maximum size, but the actual size is only the size of the guest operating 
system and any installed files.
Read Only Access: Select this option to give the drive Read-Only access.

Network

The Network page contains network settings that are stored as VM Personality Data when VM is 
checked into the warehouse. When the VM is provisioned through ZENworks Orchestrator, these 
Network settings are used. If this data does not exist, the provisioned VM uses the existing VM for 
Creating Virtual Machines 47



48 Novell

novdocx (en)  11 July 2008
network settings. The network devices are added, deleted, and defined on the Network page, where 
you add specific information about your network connections or intended network connections for 
your VM. The following graphic represents the Network Devices page.

Figure 3-5   VM Builder Network Interface Definition

The Network Device definition sections are:

Add, Move, and Delete Control Buttons: These buttons control the list order and number of 
virtual NICs in your VM.
Type of Virtual Network: Indicates whether the VM has direct access to the NIC. If the NIC 
should only interface with the hypervisor, you can select the specific type of full virtualization. 
You should have a paravirtualized NIC with a paravirtualized VM. 
MAC Address: Unless you have a specific MAC address you want to assign to this VM, leave 
this set to Default, and Xen assigns it a MAC address when you launch the VM. 
Network Address: The default selection allows DHCP to get a network address for your VM 
when it starts. You can designate a static IP address in the IP Address field, a network mask in 
the Netmask field, and the gateway in the Gateway field by deselecting the DHCP check box. 
DNS Servers: The default selection allows DHCP to get name servers for your VM when it 
starts. You can deselect the DHCP check box, then designate DNS servers in the DNS Servers 
field and DNS suffixes in the DNS Suffixes field. 
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NetBIOS: The default setting gets NetBIOS information from the DHCP, or you can use this 
drop-down menu to completely enable or disable NetBIOS.
WINS Servers: Designate any WINS servers your VM needs.
Server Hostname: The default is the name you gave to the VM. You can change this to 
anything you want the hostname to be.
Server Domain Name: Designate the domain to which the VM will belong.

3.2.3  Installing a Defined Virtual Machine
The Xen hypervisor is used to build all VMs built with the VM Builder. The following illustrates a 
defined VM:

The VM installation can also be automated using a response file. For more information, see 
“Automating the Installation Responses” on page 52.

To manually install a defined VM:

1 In the ZENworks VM Management Console, do one of the following:
Install directly by clicking Install.
Select the VM, then select File > Install.
Select the VM, then click the Install button in the toolbar.
Right-click in the Workspace window and select Install from the menu.
Double-click the VM to open the VM Builder Wizard, then click Install.
Select the VM, select File > Edit, then click Install.
Select the VM, click the Edit button in the toolbar, then click Install.
Right-click the VM, select Edit, then click Install.
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2 To monitor the progress of the VM installation, open the Virtual Network Console (VNC) by 
clicking the icon ( ).
For information on opening a VNC, see “Viewing and Interacting with the Installing Virtual 
Machine” on page 51.
For information on monitoring the installation progress in the VNC, see “Monitoring 
Installation Progress” on page 50.
For information on viewing and interacting with the VM as it’s being installed, see “Viewing 
and Interacting with the Installing Virtual Machine” on page 51.
To cancel a VM installation that is in progress, open the Progress view and click the red square 
at the end of the moving progress bar.

3 After the VM has been installed, continue with one of the following:
Section 3.2.4, “Installing the Orchestrator Agent on a Virtual Machine,” on page 52
Section 3.2.5, “Installing Applications on a Virtual Machine,” on page 53
Section 3.2.6, “Checking a Virtual Machine into the VM Warehouse,” on page 53

Monitoring Installation Progress

When you click Install, you see a progress indicator on the lower right side of the ZENworks VM 
Management Console, and you see areas that indicate activity in the build and what is being built. In 
the ZENworks VM Management Console, click Window > Show View > Progress to display the 
Progress panel.

You can also monitor the Orchestrator Server interaction with Xen during the build process. If you 
look at the Resources view, select the Resource button to see the resource chosen to be used for the 
VM Builder job as displayed in the following figure.

Figure 3-6   ZENworks Orchestrator Console Resource View in a VM Build Job
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You can also select the Jobs view to see the job, and all of its job-related monitored data as 
displayed in the following figure.

Figure 3-7   ZENworks Orchestrator Console Job View in a VM Build

Viewing and Interacting with the Installing Virtual Machine

While you are installing, if you have not designated an AutoYaST file to serve as the automated 
response file for the installation (see “Automating the Installation Responses” on page 52) you are 
required by the operating system installation to give responses to certain configuration questions. 
You can use a VNC to display the console just as if you were installing the product on a physical 
machine.

Respond to all the questions as if you were setting up the guest operating system on a physical 
machine. You can even create an AutoYaST file as part of the responses, which you can use to 
automate future VM builds.

Figure 3-8   VNC Authentication Screen
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When you have logged in and given all the parameters for the actual guest operating system 
installation, you see a window similar to the following, displaying the install progress. This is the 
same as installing on a physical machine.

Figure 3-9   VNC Console During a SLES 10 SP 1 Installation

Automating the Installation Responses

To automate the responses to your VM guest operating system installation, you can use an 
AutoYaST response file that automatically fills in all information, such as the root password, that 
you are normally required to provide during an operating system installation.

If you choose to use a response file, all responses are precisely like the previous operating system. 
The speed by which the operating system is installed is dramatically increased.

The AutoYaST file can be designated on the Definitions page of the VM Builder Wizard. If you 
choose to use an AutoYaST file, you can browse to it by clicking on the button on the right of the 
space provided.

3.2.4  Installing the Orchestrator Agent on a Virtual Machine
For a VM to be used by the Orchestrator Server as a resource for high performance computing 
(HPC), it needs to have the Orchestrator Agent installed. For instructions on installing the 
Orchestrator Agent on a VM, see “Installing the Orchestrator Agent on VMs” in the Novell 
ZENworks Orchestrator 1.3 Installation and Getting Started Guide.

You can also run a job to install the Orchestrator Agent on a VM. You need to set the constraints in 
the job to find the type of VM you want, then it automatically installs, similar to the example found 
at Section D.1, “Installing the ZENworks Orchestrator Agent on an Apache Virtual Machine,” on 
page 117.
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Continue with one of the following:

Section 3.2.5, “Installing Applications on a Virtual Machine,” on page 53
Section 3.2.6, “Checking a Virtual Machine into the VM Warehouse,” on page 53

3.2.5  Installing Applications on a Virtual Machine
To install an application on an installed VM:

1 Start the VM on a VM Host outside of your production environment.
The VM can be left running after its installation if it is installed on a VM Host outside of your 
production environment. 

2 Install whatever applications you need on the running VM.
Do this by installing the software just as you would on a physical machine.

3 After you have installed all of the applications that you need, stop the VM.
The applications remain installed the next time you start the VM.

4 Continue with Section 3.2.6, “Checking a Virtual Machine into the VM Warehouse,” on 
page 53.

3.2.6  Checking a Virtual Machine into the VM Warehouse
After you have built or discovered a VM, and installed all the software you need the VM to run, the 
VM is ready to be checked into the VM Warehouse. This can only be performed on a VM that is 
shut down or stopped.

Make sure the VM is shut down before checking it into the VM Warehouse. You must have already 
discovered your VM host machines for the xen30 provisioning adapter.

For instructions on checking an installed VM into the VM Warehouse, see Section 3.3, “Storing and 
Versioning a Virtual Machine,” on page 53.

For information on discovering VM hosts, see Section 2.2.4, “Discovering Virtual Machine Hosts,” 
on page 30.

3.3  Storing and Versioning a Virtual Machine
When you have built or discovered your VMs, and have installed all of the software you need that 
VM to be running, you can check the VMs into the VM Warehouse. The VM Warehouse stores VM 
images and the data about the first disk attached to the VM. The VM Warehouse also controls the 
versioning process.

To store and version a VM, do the following tasks:

Section 3.3.1, “Checking In a Virtual Machine,” on page 54
Section 3.3.2, “Getting Information about Warehoused Virtual Machines,” on page 54
Section 3.3.3, “Moving Other Virtual Machines into the Warehouse,” on page 54
Section 3.3.4, “Using Virtual Machines that Are Not in the Warehouse,” on page 55
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3.3.1  Checking In a Virtual Machine
The action of checking the VM into the warehouse begins the versioning process. The first version 
checked into the warehouse is designated as Gold Master and is Version 1 of the VM. If you use 
ZENworks Orchestrator Server to deploy the VM from the VM Warehouse, you deploy this version. 
For information on changing the Gold Master designation, see Section 6.3.7, “Changing the Gold 
Master Designation,” on page 74.

Any subsequent versions you check in to the warehouse are given the next sequential version 
number. The data on the versions also indicates the parent version of all succeeding versions after 
the first.

IMPORTANT: Only the first hard disk is stored with the VM image in the warehouse. All other 
disks and CD-ROM or DVD drives are ignored during check-in, but the configuration is saved to be 
redeployed with the VM when it is provisioned.

To check VMs into the VM Warehouse:

1 In the ZENworks VM Management Console, do one of the following:
Right-click the VM and select Check In. 
Select the VM, then click File > Check In. 
Select the VM and click the Check In button. 

For VMs discovered in the ZENworks Orchestrator Console, see Section 3.3.3, “Moving Other 
Virtual Machines into the Warehouse,” on page 54.

2 To deploy your VMs, continue with Chapter 5, “Deploying Virtual Machines,” on page 59.

3.3.2  Getting Information about Warehoused Virtual Machines
To get information about VMs in the VM Warehouse, double-click a warehoused VM, or right-click 
the VM in the warehouse and select Show Versions.

This provides a list of all the versions of that VM in an edit window on the right. For more 
information about the edit view window, see “Displaying Versions” on page 93.

3.3.3  Moving Other Virtual Machines into the Warehouse
If you have preexisting Xen VMs in your data center environment, you can check them into the VM 
Warehouse for version control:

1 In the ZENworks Orchestrator Console, right-click the VM in the Resource Tree.
2 Select Move Disk Images.
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The following dialog box is displayed:

Figure 3-10   Move VM Disks Dialog Box

3 In the Move VM Disks dialog box, click the drop-down Repository menu.
4 Select Warehouse.
5 Click OK.

This launches a move job to move the VM into the VM Warehouse listing and implement 
version control.

3.3.4  Using Virtual Machines that Are Not in the Warehouse
You can also choose to not move a VM into the VM Warehouse. If you choose to do this, just create 
and use your VMs as needed and delete the VM when you are finished.

You can use any VM in the system without checking it in to the VM Warehouse, but you do need to 
check it in if you want version control applied.
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4Provisioning Virtual Machines

Provisioning is used to get a Novell® ZENworks® VM ready to start in a running state. The 
Orchestrator Server automatically looks for the best VM host machine to run the VM on, unless you 
have specifically designated another server to run the VM.

Provisioning adapters on the Orchestrator Server abstract the VM. These adapters are special 
provisioning jobs that perform operations for each integration with different VM technologies.

The ZENworks Orchestrator Server uses provisioning adapters to perform life cycle functions for 
the VMs and allow the Orchestrator Server to control them. Provisioning adapters are programs that 
provision (start, stop, snapshot, migrate, or pause) a VM. They run just like regular jobs on the 
Orchestrator Server.

The system can detect a local store on each VM host and detect if a local disk might contain VM 
images. The provisioner puts in a request for a VM host. However, before a VM is used, the system 
pre-reserves that VM for exclusive use. That reservation prevents a VM from being “stolen” by any 
other job that’s waiting for a resource that might match this particular VM.

The constraints specified to find a suitable host evaluate machine architectures, CPA, bit width, 
available virtual memory, or other administrator-configured constraints, such as the number of 
virtual machine slots. This process provides heterogeneous virtual machine management.

For procedures and more information on provisioning of VMs, see “Virtual Machine Job 
Development” in the Novell ZENworks Orchestrator 1.3 Developer Guide and Reference.
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5Deploying Virtual Machines

When you are finished modifying and versioning your Novell® ZENworks® virtual machines 
(VMs), you can deploy them in your production environment and manage them. The version you 
want launched into your production environment must be designated as the Gold Master version in 
the Virtual Machine Warehouse (VM Warehouse).

In order to be able to use a VM as a resource to which you can deploy joblets from your Orchestrator 
Server, you must deploy or provision a VM. The VM can be deployed to any appropriate VM host 
machine. If the VM has the Orchestrator Agent installed on it, it can have joblets deployed to it. If 
you have not yet installed the Orchestrator Agent on the VM, you can give the job to the 
Orchestrator Server to install the Orchestrator Agent on the next startup of the machine.

Template VMs do not need to be provisioned to be used. Instead, if the template VM has the 
Orchestrator Agent installed on it and a call is made to use a VM template clone, then ZENworks 
Orchestrator automatically clones a version of the template VM and deploys it.

The Orchestrator Server automatically deploys VMs with the Orchestrator Agent installed on them 
as it would physical machines, according to one of the default jobs programmed into the 
Orchestrator Server. As it is needed, the Orchestrator Server takes one of the provisioned VMs and 
deploys a joblet to it as the job needs the additional resources.

ZENworks Orchestrator uses the Repository object to represent where VMs are stored. VMs can be 
stored on local disks, the Orchestrator Datagrid, the VM Warehouse, a network area storage (NAS), 
a storage area network (SAN), or by using a separate VM technology.

Before VMs can be used by ZENworks Orchestrator, you must create Repository objects and then 
discover the VM Images within the Repository:

Section 5.1, “Deploying a VM to the Local Repository,” on page 59
Section 5.2, “Deploying a VM to the Datagrid Repository,” on page 60
Section 5.3, “Deploying a VM to the Warehouse Repository,” on page 60
Section 5.4, “Deploying a VM to the NAS Repository,” on page 60
Section 5.5, “Deploying a VM to the SAN Repository,” on page 61

5.1  Deploying a VM to the Local Repository
By default, the Xen and VMware* server adapters create a local Repository object for local VM 
images when ZENworks Orchestrator accomplishes the Discover VM Hosts action.

A Local Repository represents VMs residing in a VM Host's local storage where the VMs are only 
visible to the VM Host. VMs are thus searched for in the default paths for each adapter.

IMPORTANT: Do not use Local Repositories for shared directories visible to more than one VM 
Host. Instead, create a new NAS/SAN Repository.

For information on NAS storage, see “Deploying a VM to the NAS Repository” on page 60. For 
information on SAN storage, see “Deploying a VM to the SAN Repository” on page 61.
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When discovering VM Images, the adapters use the location, searchpath and 
preferredpath facts for searching. The repository.location is usually the root path, 
such as /. For Xen, the adapter creates a Local Repository with search paths of /etc/xen/vm and 
a preferred search path of /var/lib/xen/images.

When the Discover VM Images is run, the provisioning adapter follows these steps:

Concatenates the repository.location and every element of 
repository.searchpath and searches for VMs in those directories.
Concatenates the repository.location and repository.preferredpath and 
searches for VMs in that directory.

These steps are also followed when searching in NAS and SAN repositories when representing auto-
mounted file systems, and when the location, search path, and preferred path are set.

For more information on facts, see “Defining Values for Grid Objects” in the Novell ZENworks 
Orchestrator 1.3 Developer Guide and Reference.

5.2  Deploying a VM to the Datagrid Repository
By default, a Datagrid Repository named zos is automatically created. The Datagrid Repository 
represents VMs residing in the ZENworks Orchestrator Datagrid, which is a storage area on the 
Orchestrator Server.

The zos Datagrid Repository has a location of grid:///vms, which points to an area in the 
Datagrid reserved for VM archival storage.

You can store VMs to the Datagrid and deploy to a VM host as necessary.

The Datagrid Repository storage is archival because VMs cannot be run from the Datagrid 
Repository. You must move VMs out of the DataGrid to a VM Host in order to run them.

5.3  Deploying a VM to the Warehouse Repository
The Warehouse Repository represents the VMs stored in the VM Warehouse Server. The 
Warehouse Repository is supported only by the Xen adapter.

If you have installed the VM Warehouse Server, then run Discover VM Hosts. The Xen adapter 
creates a Warehouse Repository named Warehouse.

If you run Discover VM Images on the Warehouse Repository, it displays the inventory of Gold 
Master VMs in ZENworks Orchestrator. These are the Gold Master versions stored in the VM 
Warehouse. The discovered Gold Master VMs can then be provisioned to VM Hosts.

VMs cannot run from the Warehouse Repository, so any provisioning actions must first export a VM 
from the warehouse.

5.4  Deploying a VM to the NAS Repository
The Network Attached Storage (NAS) Repository represents VMs stored in a NAS. This is a storage 
where VMs are visible to multiple VM Hosts, so they can be run by any one of the available hosts.
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The following procedure shows an example of setting up a NAS Repository. For the example, 
assume you have a Xen setup where the directory /vms is auto-mounted on multiple VM hosts as 
the shared storage location for your VMs.

To deploy a VM to the NAS Repository:

1 To create a new Repository object, go to the ZENworks Orchestrator Console, then click 
Actions > Create Repository.

2 Specify a new name and choose which adapter group this Repository is used for.
The example is for Xen VMs, so choose the xen30 adapter.

3 Close the dialog box to display the Info/Groups tab for the new repository.
4 Set the location path.

This is the root path for the repository. It is usually /.
5 Set the search path and preferred path.

In this example, the vms are all in /vms, so leave searchpath empty and set the 
preferredpath == "vms".

6 Select the VM Host objects that have visibility to the shared directory and add the new 
repository to the VM hosts list of available Repositories.
To find a VM host, either go the VM Hosts view or open the Physical tree under Resources and 
open the physical host representing the VM host.

7 Run Provision > Discover VM Images on the new Repository.

5.5  Deploying a VM to the SAN Repository
The Storage Area Network (SAN) Repository is a single storage server that can be accessed by 
multiple machines.

NOTE: This section refers to an iSCSI SAN, not a Fibre Channel SAN.

There are two ways to access VMs on a SAN:

The SAN is auto-mounted.

For an auto-mounted SAN, follow the setup steps noted in “Deploying a VM to the NAS 
Repository” on page 60 in setting the facts for identifying the paths.

For more information on facts, see “Defining Values for Grid Objects” in the Novell ZENworks 
Orchestrator 1.3 Developer Guide and Reference.
The Orchestrator Server managing the connection requires additional information to have the 
SAN as an available repository for VM images.
For example, the physical disks are on the SAN, but the configuration file is on local storage. 
The additional information is necessary for ZENworks Orchestrator to know how to bind or 
connect the SAN disk on the VM host.

Perform the tasks in the following sections, as applicable:

Section 5.5.1, “Setting Up the SAN,” on page 62
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Section 5.5.2, “Configuring the iSCSI SAN in ZENworks Orchestrator,” on page 63
Section 5.5.3, “Virtual Repository,” on page 64

5.5.1  Setting Up the SAN
For information on setting up an iSCSI target, see Setting Up an iSCSI Target (http://
www.novell.com/documentation/sles10/sles_admin/index.html?page=/documentation/sles10/
sles_admin/data/sec_inst_system_iscsi_target.html) in the SUSE Linux Enterprise Server 10 
Installation and Administration Guide.

For information on setting up an iSCSI Initiator, see Configuring iSCSI Initiator (http://
www.novell.com/documentation/sles10/sles_admin/index.html?page=/documentation/sles10/
sles_admin/data/sec_inst_system_iscsi_initiator.html) in the SUSE Linux Enterprise Server 10 
Installation and Administration Guide. 

You need to have one of the following for the setup:

On the server, create a file or partition that has sufficient size for a VM image.
Have or select a VM disk image.

You can set up the iSCSI target according to the linked directions above, or you can use a VM image 
as your target. With the addition of the optional instructions on installing on a VM Image are 
included here.

NOTE: If the iSCSI Target is not installed, you are prompted to install the iscsitarget 
package. 

To install the target (iSCSI Server) and complete setting up the SAN:

1 On the ZENworks Orchestrator Server, open YaST2.
2 Click iSCSI Target in the Miscellaneous section. 
3 Select the When Booting option in the Service Start section. Select the Global tab and set up 

global authentication if needed. If you are not using authentication, select No Authentication. 
Select the Targets tab. 

4 There should be a default iSCSI target in the Targets list. Delete this example target. 
5 Click Add. 
6 Click Add again. 
7 Select Type=fileio.
8 Specify the path to the created partition, file, or VM Image.
9 Click OK.

10 Click Next.
11 Specify any authentication information for incoming or outgoing stored VMs, or select No 

Authentication.
12 Select Finish. A dialog box appears, asking you to restart the service.
13 Click Yes.
14 After you have installed and configured your iSCSI Target and Initiator, run $hwinfo -

disk to see something similar to the following:
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Model: "IET VIRTUAL-DISK"  Vendor: "IET"  Device: "VIRTUAL-DISK"  Revision: "0"  
Driver: "sd"  Device File: /dev/sdb (/dev/sg2)

NOTE: Notice the virtual disk and the new device file that appear. This shows that the iSCSI 
initiator has established a connection and is able to attach to the file, partition, or VM image. If 
this information does not appear, troubleshoot the iSCSI connection and setup.

15 To create a Xen configuration file and start the VM:
15a Enter $virt-manager at a command line prompt.
15b Either create a new VM or select I have a disk or disk image.
15c Select Disks.
15d Enter the new device file location as found in the hwinfo -disk command output.

5.5.2  Configuring the iSCSI SAN in ZENworks Orchestrator
After you have set the SAN up outside of ZENworks Orchestrator, launch the ZENworks 
Orchestrator Console.

Perform the following steps if your iSCSI SAN is a VM Image:

1 Click Provision > Discover VM Images. 
2 Ensure that the new VM appears on the tree.
3 Right-click Repositories and select New Repository. 
4 Name the new repository.
5 Add the xen30 provisioning adapter.

For information on provisioning adapters, see Chapter 4, “Provisioning Virtual Machines,” on 
page 57.

6 Click Create. 
7 Select the new repository from the list.
8 In the large window on the right, fill in the following information:

Type = SAN
In the SAN Specific Configuration section, fill in the following information: 

SAN Type = iSCSI
SAN Vendor = "iqn"

9 Select Save from the toolbar icon or the file menu. 
10 Click the Resources selection in the tree.
11 Select the new VM.
12 On the right select Info/Groups and select the Browse button (…). find the Virtual Disks Layout 
13 Click the drop-down menu to change the information.

For example:

iqn: iqn.2007-05.lab.cimlocation: phy:/dev/sdbmoveable: left 
uncheckedrepository: iscsisize: 0 (untouched)

14 Test the new setup by provisioning a VM.
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For information, see “Provisioning Virtual Machines” in the Novell ZENworks Orchestrator 
1.3 Developer Guide and Reference.

15 Check the Job Log for bind/unbind operations similar to this:

iscsi unbind(iqn=iqn.2007-05.lab.cim,u=None,pw=None,auth=None) Running 
'iscsiadm -m node' rslt= 0 Found record for iqn: e375f3 Run cmd: iscsiadm -m 
node -r e375f3 -urslt= 0unbind was successful

5.5.3  Virtual Repository
A Virtual Repository is where ZENworks Orchestrator assumes the VM store is handled by the 
underlying VM technology. For example, the Virtual Repository is used by the Virtual Center 
adapter because Virtual Center is managing the VM storage.
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6Ongoing Management of Virtual 
Machines

Review the following sections for ongoing tasks in Novell® ZENworks® VM Management:

Section 6.1, “Destroying a Virtual Machine,” on page 65
Section 6.2, “Managing a Virtual Machine in Runtime,” on page 65
Section 6.3, “Modifying a Virtual Machine after Checking In,” on page 71
Section 6.4, “Monitoring Virtual Machines,” on page 74
Section 6.5, “Using a Virtual Machine Not Checked in to the Warehouse,” on page 77
Section 6.6, “Using the Orchestrator User Portal to Run VM Jobs,” on page 78

6.1  Destroying a Virtual Machine
1 In the ZENworks Orchestrator Console, right-click the VM in the tree and select Delete/

Destroy Resource.
This action removes the VM from your resource list. However, the actual image of the VM is 
still stored in its directory. If the VM was stored in the VM Warehouse, it is retained there.

2 If you deleted a VM from your resource tree, rediscover the VM by running a discovery job. 
Click Provision > Discover VM Images to rediscover any VMs in your data center with unique 
UUIDs.

3 To delete a VM from the VM Warehouse, right-click the VM in the ZENworks VM 
Management Console and select Delete.
This completely deletes the VM and all its versions from your data center. You cannot restore 
any version of the VM after you delete it from the warehouse. However, if you do have a 
checked-out instance of the VM, you can check that back into the warehouse.

6.2  Managing a Virtual Machine in Runtime
There are many ways you can control the VM after it has been deployed from the warehouse. All 
actions from provisioning to shutting down the VM can be managed directly from the ZENworks 
Orchestrator Console and through the jobs written and executed by the Orchestrator Server.

Review the following sections for ways to manage VMs in runtime:

Section 6.2.1, “Provisioning Actions from the Right-Click Menu,” on page 66
Section 6.2.2, “Releasing a Virtual Machine from Usage,” on page 67
Section 6.2.3, “Managing Virtual Machine Templates,” on page 67
Section 6.2.4, “Managed Virtual Machine Actions,” on page 70
Section 6.2.5, “Virtual Machine Technology-Specific Actions,” on page 70
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6.2.1  Provisioning Actions from the Right-Click Menu
You can perform provisioning actions by right-clicking a VM in the tree of the ZENworks 
Orchestrator Console. You start VMs by provisioning them under the VMs list according to the 
appropriate provisioning adapter.

For information on provisioning adapters, see Chapter 4, “Provisioning Virtual Machines,” on 
page 57.

For information on provisioning a VM and on the usable provisioning adapters, see Section 6.2.4, 
“Managed Virtual Machine Actions,” on page 70.

The provisioning actions available from the right-click menu are as follows:

Table 6-1   Right-Click VM Commands

Action Description

Provision Starts a VM to a running state. The Orchestrator Server automatically 
looks for the best VM host machine to run the VM on, unless you 
have specifically designated another server to run the VM.

Pause Prevents the VM from gaining access to the processor of the host 
machine, although it is still resident in the memory of the host 
machine.

Resume Allows a paused VM to access the processor of the host machine 
again.

Suspend Pauses the VM and takes a snapshot of its disk and memory status. 
In the suspended state, a VM can be moved or migrated to another 
host machine.

Shutdown Stops a VM from running, just like shutting down a physical machine. 
The operating system stops and acts as if it is shut down.

Restart Shuts down and restarts a running VM.

Migrate Moves a VM that is shut down from one host machine to another. This 
action is a “live migration” as opposed to moving the disk image with 
a “cold” VM.

Resync State Assures that the state of the VM displayed in the ZENworks 
Orchestrator Console is accurate.

Save Config Commits runtime modifications of VM properties (such as adding 
more virtual memory or a new application during runtime) to the VM 
Warehouse.

Apply Config Updates the VM’s transient configuration. The VM must be running. 
This action is not supported in ZENworks Orchestrator 1.3.

Create Template Makes a VM instance into a template from which other versions can 
be cloned. This menu item is replaced by the Clone menu item when 
you right-click a template VM.

Clone Launches a cloned instance of the template VM.

Delete/Destroy Resource Removes a VM from the Resources list in the ZENworks Orchestrator 
Console. 
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6.2.2  Releasing a Virtual Machine from Usage
When the demand and load on your data center decreases, the Orchestrator Server analyzes the 
remaining resources and releases the most appropriate resource. If a VM meets the requirements of 
the remaining job demands better than a physical machine, then the physical machine is released 
before the VM is released. This dynamic analysis allows you to make sure that the needs of your 
data center are met.

6.2.3  Managing Virtual Machine Templates
A VM template is a special kind of VM that is not deployed separately. When the Orchestrator 
Server needs a VM of the template’s type to be used as a resource, it automatically clones a version 
of the VM and uses that clone as the VM. You can change cloned VMs into instances of VMs 
instead of clones.

Review the following tasks to manage VM templates:

“Making a Virtual Machine Instance into a Template” on page 68
“Ending the Clone” on page 69
“Changing a Virtual Machine Template Clone to an Instance” on page 69

Move Disk Images Migrates a disk image from one storage location to another. Select 
the storage location from the drop-down menu. You can also move a 
VM from one VM host machine to another. This is a “cold” migration. 
VMware Server VMs must be migrated in this manner.

Checkpoint Creates a named snapshot of a VM image. This image is stored on 
the disk of the repository machine. Xen VMs cannot have a 
checkpoint applied to them.

Restore Starts a Checkpoint VM (that is, resumes the operations of a VM 
made into a stored checkpoint from the moment of storage).

Remove Template Dependency Changes a cloned instance of a VM into a VM instance.

Install Agent Launches a job that automatically installs the Orchestrator Agent on a 
VM the next time you provision the VM.

Personalize Allows you to customize the VM. This includes changing elements 
like the DNS server. The changes are made to a VM that is shut 
down.

Shutdown Agent Shuts down the Orchestrator Agent and makes the VM unavailable as 
a resource.

Cancel Action Stops an action that has been requested.

Check Host Assignment Opens a window so you can compare the VM hosts capable of 
hosting the VM.

Launch Remote Desktop Launches a VNC terminal in which you can view and control the VM.

Action Description
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Making a Virtual Machine Instance into a Template

1 In the ZENworks Orchestrator Console, right-click the VM.
2 Select Create Template.

In Linux:

In Windows:

3 Name the template.
4 Specify a repository.
5 Specify a visible VM host.
6 Select a recommended host for the VMs to be launched on, if any are present.
7 Click OK.
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When the clone of the template VM is provisioned, it appears as a sub-branch of the template’s 
location in the resources tree, as in the following Linux and Windows examples:

Figure 6-1   VM Template with Daughter Clone

Figure 6-2   VM Template with Daughter Clone

This clone functions as an instance of a VM and runs as though it were its own version with its own 
MAC address and other unique identifiers. The UUID is the only new information that is 
automatically generated for the clone. All the rest of the new information comes from autoprep, 
including the MAC address if an asterisk (*) is placed in the Mac Address field in the Autoprep 
Network Adapter section of the Info/Groups tab for the template (the default is a blank field, 
meaning no MAC address is created), and if the Use Autoprep check box is enabled on the Create 
VM from Template dialog box.

Ending the Clone

When the Orchestrator Server no longer needs the clone, it deprovisions it and automatically deletes 
it from the data center.

Changing a Virtual Machine Template Clone to an Instance

1 If you decide to keep a clone VM, go to the ZENworks Orchestrator Console, right-click it, and 
select Remove Template Dependency.
This brings up the Remove Template Dependency dialog box, shown in the following figure:

Figure 6-3   Remove Template Dependency Dialog Box

2 Click OK.
Ongoing Management of Virtual Machines 69



70 Novell

novdocx (en)  11 July 2008
6.2.4  Managed Virtual Machine Actions
You can perform many actions on the VM through the ZENworks Orchestrator Console and 
ZENworks VM Management Console or you can write jobs to have actions performed on the VMs 
in your data center. The following table lists the managed VM actions that you can perform or use in 
a written job.

Table 6-2   Managed VM Actions

6.2.5  Virtual Machine Technology-Specific Actions
For a detailed breakdown of the actions you can perform to and with a VM, see the appropriate VM 
technology and configuration section in Appendix C, “Virtual Machine Technologies and Actions,” 
on page 99.

Action Description

Provision Starts a VM. This action clones and start a cloned VM template.

Clone Creates a new, unique instance of a VM template.

Cold Migrate Moves the storage location of the configuration and first disk files to another 
physical storage host. This might allow the VM to start faster.

Shutdown Stops an active VM instance (including a started template VM).

Destroy Restarts (reprovisions) an active VM.

Suspend Takes a snapshot of an active VM and pauses it in order to move it to 
another VM host. 

Pause Prevents the VM from obtaining CPU cycles, but it stays resident.

Resume Allows a paused VM to access the CPU again.

Create Template Creates a VM template from a VM instance.

Hot Migrate Moves the storage location of an active VM, its disks and configuration, to 
another VM host machine.

Checkpoint Create a named snapshot of a moment that can later be accessed to restart 
from the same point

Restore Resumes a VM at a previously stored checkpoint.

Install Orchestrator Agent Opens a VM image and installs the Orchestrator Agent.

Make Standalone Removes the association of a template and makes the active VM into its 
own instance.

Check Status Checks the current state of the VM to verify if the VM is provisioned or shut 
down.

Personalize Modifies the Orchestrator Agent properties and disk image that are currently 
part of a clone.

Save Config Transfers changes made to a VM to its permanent image storage.
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6.3  Modifying a Virtual Machine after Checking In
After a VM has been checked in to the warehouse, you can check it out again to make changes to the 
properties and storage data. You can then check the VM back in to the warehouse to create the next 
version of the VM.

Section 6.3.1, “Checking Out a Virtual Machine,” on page 71
Section 6.3.2, “Modifying Virtual Machine Properties,” on page 71
Section 6.3.3, “Modifying and Adding Applications to a Checked-Out Virtual Machine,” on 
page 72
Section 6.3.4, “Assuring Sufficient Loopback Devices to Allow for Virtual Machines,” on 
page 73
Section 6.3.5, “Testing a Virtual Machine Modification,” on page 74
Section 6.3.6, “Checking In an Edited Virtual Machine,” on page 74
Section 6.3.7, “Changing the Gold Master Designation,” on page 74

6.3.1  Checking Out a Virtual Machine 
To check a VM out of the warehouse, go to the ZENworks VM Management Console, right-click 
the VM, and select Check Out. Checking out a VM moves a copy of the VM into the Workspace 
section of the ZENworks VM Management Console. When it is there, you can modify the VM. For 
information on the ZENworks VM Management Console, see “Workspace View” on page 89. 

6.3.2  Modifying Virtual Machine Properties
When a VM is in a Checked Out status, it can be modified and edited. There are two different types 
of edit you can perform on the VM in the ZENworks VM Management Console: 

Edit: Allows you to change elements of the metadata on the VM.
Edit Image: Allows you to create a copy of the VM that is put elsewhere on the drive, so you 
can open the VM image and change its inherent metadata, processor architecture, initial hard 
disk properties, memory properties, and so forth.

To start the edit process:

1 In the ZENworks VM Management Console, select the VM you want to edit.
2 Do one of the following:

Select the Edit or Edit Image options in the File menu. 
Click the Edit or Edit Image icons in the toolbar. 
Right-click the VM and select Edit or Edit Image 

When you click Edit, the VM Builder Wizard opens again, allowing you to change elements of 
the metadata of the VM. When you click Edit Image, a version of the VM is saved to a selected 
directory, where you can open it and make changes to the image itself. 

“Using the Edit Tool to Edit Virtual Machine Metadata” on page 72
“Editing the Virtual Machine Image” on page 72
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Using the Edit Tool to Edit Virtual Machine Metadata

When you right-click a VM in the Workspace panel, you can choose Edit to open the VM Builder 
Wizard. If the VM has the status of Defining, you can edit any of the initial VM Builder fields. The 
VM has not yet been built, so you can still add things to the overall metadata for the VM. However, 
if the VM has been installed or checked out, you can change only the following: 

The VM description
Any additional arguments
VM crash instructions
Number and priority weight of processors
Startup and maximum memory allocations
Graphic mode (if you have fully virtualized the VM)
Additional hard disks and CD or DVD disk drives
Additional NICs
Virtual network interface details
Server name information

Editing the Virtual Machine Image

Click Edit Image to actually edit elements beyond the VM metadata. A dialog box is displayed that 
tells you where the image is located so that you can open the VM image and modify it:

Figure 6-4   VM Image Location Dialog Box

6.3.3  Modifying and Adding Applications to a Checked-Out 
Virtual Machine
A VM behaves as if it is a single, physical machine. While it is running, you can add any application 
to the VM that you need. If these applications are made on the first hard disk, the applications are 
saved as part of the VM image and are called upon when the VM is started again.

One of the specific modifications you might want to make to a VM is to install the Orchestrator VM 
Agent Pattern in YaST, so the VM is available to ZENworks Orchestrator. For instructions on 
installing the Orchestrator Agent on a VM, see “Installing the Orchestrator Agent on VMs” in the 
Novell ZENworks Orchestrator 1.3 Installation and Getting Started Guide.
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6.3.4  Assuring Sufficient Loopback Devices to Allow for Virtual 
Machines
The Linux kernel allows for a set number of loopback devices. The default is 64 for the version of 
Linux supported by ZENworks Virtual Machine Management.

The available loopback devices are for all VMs in the grid. The default setting for the allowed 
number of loopback devices can be changed in the kernel.

When you run a VM, the Orchestrator Server requires one of those loopback devices for the VM 
Prep job. The VM Prep job is a shared part of the provisioning adapters. It is used to personalize a 
VM (that is change identity and network configuration—the so-called autoprep facts). It works by 
mounting the VM disk over loopback and then modifying configuration files in the VM disk image 
(via the mount). For more information on the provisioning adapters and their function, see 
Section 6.2.1, “Provisioning Actions from the Right-Click Menu,” on page 66.

When you use the Orchestrator Server to launch a VM, you need to make sure that there are enough 
loopback devices remaining to support that VM. For example, if the VM has seven mounted 
loopback devices, a VM host machine must have at least eight available loopback devices to allow 
for the seven for the VM and one more for the VM Prep job.

If the VM host machine is using a loopback device, this device also counts against the total. You can 
create a VM without a loopback device, which does not count against the total.

To manage loopback devices:

“Setting Up Loopback Devices in the Virtual Machine” on page 73
“Changing the Number of Allowed Virtual Machines” on page 73

Setting Up Loopback Devices in the Virtual Machine

You can designate loopback devices by running the VM and mounting the ISO or software you want 
to have as a mounted loopback device by using mount -o loop command, just as you would on 
a physical machine. The number of loopback devices in the VM do not count against the total 
allowable loopback devices of the host machine.

Changing the Number of Allowed Virtual Machines

In order to change the VM hosts in your data center grid, be sure that you have already discovered 
your VM hosts and your VMs. For information on discovering VM hosts and VMs, see 
Section 2.2.4, “Discovering Virtual Machine Hosts,” on page 30.

To change the number of allowed VMs on a VM host machine:

1 In the ZENworks Orchestrator Console, open the grid containing the VM host you want to 
change.

2 Select Resources in the tree menu.
3 Select All.
4 Select the VM host machine.
5 On the Info page change the Max Hosted VMs to a number equal to one less than your Linux 

kernel’s allowed number of loopback devices, or as many as the VM host machine’s hardware 
allows.
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6.3.5  Testing a Virtual Machine Modification
One of the benefits of modifying a VM before checking it into the VM Warehouse is the opportunity 
to test the VM configuration.

You can continue to make changes throughout the test process until the VM meets your 
organization’s standards for VMs.

Test the VM by keeping it active until you have finished your testing. When you are finished, shut 
the VM down and check it into the warehouse.

6.3.6  Checking In an Edited Virtual Machine
When you have made a modification, and at any point during your testing cycle, you can check a 
VM back in to the VM Warehouse. Check it back in as you did the first time you checked the VM in 
to the warehouse. For more information, see Section 3.3.1, “Checking In a Virtual Machine,” on 
page 54.

The newly checked-in VM receives the next version number for that VM.

Any version can be checked back out, modified, and checked back in to increment to the next 
version number.

6.3.7  Changing the Gold Master Designation
The first time you check a VM into the VM Warehouse, it is designated as Version 1, which is also 
the Gold Master version. After you have moved one or more modified versions of the VM back into 
the VM Warehouse, they are listed in the edit view in the order they were checked in, along with 
their parent versions.

When a version you have created has passed necessary testing, you can designate it as Gold Master 
by doing any of the following:

Right-click the version, then select Make Gold Master.
Click File > Make Gold Master.
Click the Make Gold Master icon on the toolbar.

The Gold Master is the version of the VM discovered by the Orchestrator Server. It is launched 
when the VM is used as a resource to receive joblets.

6.4  Monitoring Virtual Machines
There are two different types of monitoring provided by ZENworks Orchestrator with the VM 
Management functionality:

Direct monitoring in the ZENworks VM Management Console
Monitoring in the Orchestrator Server
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The monitored data in the ZENworks VM Management Console can be used to influence decisions 
about machines to constrain to use specific joblets and be hosts to specific VMs. For the monitored 
data on the Orchestrator Server, you can view the information by looking at the Jobs section of the 
ZENworks Orchestrator Console. This information is used as feedback for jobs being executed by 
the Orchestrator Server.

Review the following sections for how to monitor VMs:

Section 6.4.1, “Using the ZENworks VM Management Console Monitoring View,” on page 75
Section 6.4.2, “Monitoring Orchestrator Server Jobs,” on page 77

6.4.1  Using the ZENworks VM Management Console 
Monitoring View
When you are in the ZENworks VM Management Console, you can access information about your 
grid environment. To see the monitoring perspective:

1 In the ZENworks VM Management Console, click the Monitoring button on the upper right 
side of the console.

2 Open the Grid-Node folder in the Monitored Servers view.
3 Provide your login name and password:

4 Select the node for which you want information.
5 Double-click the node icon to display an edit view on the right.

The following illustrates the Graphical Host View:
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6 To change the time frame for observing the server performance, click in the Last field. 
7 If you want to see the information in a text-based layout instead of a graphical layout, click 

Text Host View to display the following:
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6.4.2  Monitoring Orchestrator Server Jobs
The Orchestrator Server monitors each job it deploys. It does this through multiple means, including 
the Orchestrator Agent installed on each of the nodes in the data center. The Agent reports processor 
load, memory usage, and basic operating system and processor information. This data is constantly 
used by the Orchestrator Server in making decisions about where to deploy joblets for a running job. 
The Orchestrator Server also sends out “discovery jobs” periodically (such as when an agent on a 
managed resource starts) to assess capabilities of the machine to run a joblet. ZENworks 
Orchestrator keeps a state or model of the VM location, basic health, and action facts. These facts 
and information are used to monitor the progress of a joblet and can be used to automatically 
reassign joblets based on policies, node failure, or operator intervention. For more information about 
the actual monitoring elements of the Orchestrator Server, see “What Is ZENworks Orchestrator?” 
in the Novell ZENworks Orchestrator 1.3 Installation and Getting Started Guide.

6.5  Using a Virtual Machine Not Checked in to 
the Warehouse
If you create a VM to be used in your data center and you do not want to store it in the VM 
Warehouse, you can use the VM Builder to create it. However, when you are finished building the 
VM and it is listed in its Installed state, do not check it in. This allows you to save information on 
any additional hard disk drives you have designated during the build process of the VM.

After the VM is listed as Installed, you can go to the ZENworks Orchestrator Console and click 
Provision > Discover VM Images to discover the newly created VM. After you have discovered it, 
you can provision it and use all the provisioning menu actions on it.
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When you are finished using the VM, you can remove it from its listing in the ZENworks 
Orchestrator Console and delete it from the Workspace in the ZENworks VM Management Console. 
However, to completely remove the image from the computer, you must delete its image and the 
configuration files found in /etc/xen/vm/ and /var/lib/xen/images/.

6.6  Using the Orchestrator User Portal to Run 
VM Jobs
To use the User Portal, see “Using the ZENworks Orchestrator User Portal” in the Novell ZENworks 
Orchestrator 1.3 Job Management Guide.
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AManagement Consoles for 
ZENworks VM Management

Novell® ZENworks® Virtual Machine Management (VM Management) uses two different 
management consoles: ZENworks Orchestrator and ZENworks VM Management. They are used in 
the following ways:

ZENworks Orchestrator Console: This console is used to manage and use existing VMs in 
your data center. It resides on the ZENworks Orchestrator Server, but it can be accessed from 
an administration device.

In its tree view, the ZENworks Orchestrator Console shows all available physical machines, 
VM host machines, VMs, and VM Builder host machines that are available in your managed 
data center. It provides the following administrative functions for VM Management:

Discover VM hosts
Discover existing VMs
Deploy VMs to various repositories
Provision VMs
Migrate or move VMs
Destroy VMs (remove them from the resource tree)
Restore and resynchronize VMs
Clone VMs
Create VM templates
Stop, start, suspend, and restart VM operations
Create a job that installs the Orchestrator Agent on the VMs
Create jobs for managing VMs
Use VMs not checked into the warehouse
Connect to a VMware Virtual Center

ZENworks VM Management Console: This console is used to create, edit, and store VMs. It 
is installed on administration devices. It provides the following administrative functions for 
VM Management:

General management of VM Management from the Home page
Build (define and install) VMs
Install applications on VMs
Review the properties of VMs
Edit VMs
Test VMs
Check VMs in and out of the warehouse (includes versioning of the VMs)
Monitor the status of the VMs
Change a VM's Gold Master designation
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Retire or delete VMs
Run jobs created for managing VMs

The following sections provide details on the two consoles, including some tips and tricks in using 
the ZENworks VM Management Console:

Section A.1, “The ZENworks Orchestrator Console,” on page 80
Section A.2, “The ZENworks VM Management Console,” on page 84
Section A.3, “Tips and Tricks with the ZENworks VM Management Console,” on page 94

A.1  The ZENworks Orchestrator Console
The ZENworks Orchestrator Console is the main operations center for the Orchestrator Server. It is 
installed with the ZENworks Orchestrator Client and the Orchestrator Server when you install in 
YaST. To launch the ZENworks Orchestrator Console, go to the /opt/novell/zenworks/
zos/server/bin and run the./zoc command. Log into the server. For information on general 
ZENworks Orchestrator Console operations, see “ Walkthrough: Launch the ZENworks 
Orchestrator Console ” in theNovell ZENworks Orchestrator 1.3 Installation and Getting Started 
Guide.

Section A.1.1, “Launching the ZENworks Orchestrator Console,” on page 80
Section A.1.2, “ZENworks Orchestrator Console VM Management Actions,” on page 84
Section A.1.3, “Using Virtual Machines as Resources,” on page 84

A.1.1  Launching the ZENworks Orchestrator Console
You can do this from either the VM Warehouse/Builder server, or from a workstation:

“From the VM Warehouse/Builder server” on page 80
“From Your Linux Workstation” on page 81
“From Your Windows Workstation” on page 83

From the VM Warehouse/Builder server

1 Open a command terminal.
2 Change to the /opt/novell/zenworks/zos/server/bin/ directory.
3 Enter $./zoc to open the ZENworks Orchestrator Console:

4 Click your grid in the tree view to open the login dialog box:
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5 Enter your ZENworks Orchestrator Console administrator username and password.
The tree is expanded for your grid, as shown in this illustration:

From Your Linux Workstation

1 Open a command terminal.
2 To connect to the VM Warehouse/Builder server, enter the following command:

ssh -X root@URL

where URL is the URL of the server.
3 Log in with root privileges.
4 Change to the /opt/novell/zenworks/zos/server/bin/ directory and enter the 

following command:

./zoc

This opens the ZENworks Orchestrator Console:
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NOTE: You can also use this command terminal to open the ZENworks VM Management 
Console by entering ./zoc & instead.

5 Click your grid in the tree view to open the login dialog box:

6 Enter your ZENworks Orchestrator Console administrator username and password.
The tree is expanded for your grid, as shown in this illustration:
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From Your Windows Workstation

1 Double-click the ZENworks Orchestrator Console icon ( ) on your desktop to open the 
ZENworks Orchestrator Console:

2 Click your grid in the tree view to open the login dialog box:

3 Enter your ZENworks Orchestrator Console administrator username and password.
The tree is expanded for your grid, as shown in this illustration:
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A.1.2  ZENworks Orchestrator Console VM Management 
Actions
There are several important actions to do with your VMs in the ZENworks Orchestrator Console. 
These include finding the VMs from the Provision menu and operating the VMs from the right-click 
menu. These actions include the following: 

Discover VM Hosts: Use the Provision > Discover VM Hosts menu to discover all VM host 
machines with the Orchestrator Agent installed on them. For more information on discovering 
VM hosts, see Section 2.2.4, “Discovering Virtual Machine Hosts,” on page 30. 
Discover VMs: Use the Provision > Discover VM Images menu to discover all the VMs 
available in the VM Warehouse that are deployable to your VM hosts. You can also choose the 
Repository in the Repositories menu in the tree, right-click it and select Discover VM Images to 
discover the VM images stored on that specific storage location. These are sorted according to 
the provisioning adapter. For more information on discovering VMs, see Section 3.1, 
“Discovering Existing Virtual Machines,” on page 39. 
For further information on the actions to take after you have discovered your VMs, see 
Section 6.2, “Managing a Virtual Machine in Runtime,” on page 65.

A.1.3  Using Virtual Machines as Resources
After you have discovered all the VMs in your data center and provisioned them, you can write jobs 
and create constraints to use VMs just as the Orchestrator Server uses physical machines. For more 
information on using VMs in your data center, see Chapter 5, “Deploying Virtual Machines,” on 
page 59.

A.2  The ZENworks VM Management Console
The Novell ZENworks Virtual Machine Management (VM Management) Console, built on an 
Eclipse-based rich client platform, uses a graphical user interface (GUI) to help you build and 
manage the VMs in your data center. This GUI provides management and access to the VM Builder 
and the VM Warehouse.

Section A.2.1, “Launching the ZENworks VM Management Console,” on page 84
Section A.2.2, “Introduction to the ZENworks VM Management Console,” on page 86
Section A.2.3, “The Monitoring Perspective,” on page 93

A.2.1  Launching the ZENworks VM Management Console
You can run the ZENworks VM Management Console on both Linux and Windows workstations:

Using a Linux Workstation

1 On your Linux workstation, open a command terminal, change to the /opt/novell/
zenworks/vmmanagement/bin/ directory, and enter the following command:

./run_nvmm.sh

2 Close the Welcome pages to display the login window.
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3 Specify the IP address of the server running the VM Warehouse and VM Builder.
4 Enter a username and password with root privileges on the VM Warehouse/Builder server, then 

click Login.
The console sections are filled in.

Using a Windows Workstation

1 On your Windows workstation, double-click the Virtual Machine Management Console icon 
( ) to open the console.
The first time you log in, the following Welcome page is displayed:

2 Close the Welcome page to display the following login window:

In subsequent logins, an empty console is displayed with the login dialog box:
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3 Specify the IP address of the server running the VM Warehouse and VM Builder.
4 Enter a username and password with root privileges on the VM Warehouse/Builder server, then 

click Login.
The console sections are filled in. For example:

A.2.2  Introduction to the ZENworks VM Management Console
This section introduces you to the components of the GUI and gets you started managing your VMs 
in your data center. The GUI consists of the Welcome pages and two collections of Views called 
Perspectives.

“VM Management Welcome Page” on page 87
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“Basic VM Management Functionality” on page 88
“Virtual Machine Builder and Warehouse Perspective” on page 89

VM Management Welcome Page

The first time you start ZENworks VM Management, the Welcome page displays. This page shows 
several buttons that take you to other pages containing more detailed information about the product. 

Figure A-1   ZENworks VM Management Console Welcome Page

This home page of VM Management gives you quick access to answers for your questions 
concerning VM Management.

The Overview page contains links to a basic overview of VM Management, ZENworks Orchestrator 
Server, and the VM life cycle.

The Latest Features page gives you links to new features and information about the product. Latest 
Features also highlights any improvements since the previous release of the software.

The Web Resources page gives you many different Web links to access various associated Web sites 
including product pages, information about BrainShare®, press releases, online documentation for 
VM Management and ZENworks Orchestrator Support, and other useful information.

Manage Your VMs launches the ZENworks VM Management Console, where you can begin 
managing the VMs in your data center. 

The welcome pages can be accessed again at any time by clicking Help > Welcome. 
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Basic VM Management Functionality

The ZENworks VM Management Console is designed to let you customize the overall look and feel 
of your console. If you want to return to the initial perspective view, click Window > Reset 
Perspective. 

“Moving and Resizing Views” on page 88
“Combining Views” on page 88
“Refreshing, Minimizing, and Maximizing Views” on page 88
“Popping Out a View” on page 88
“Tips and Tricks” on page 88

Moving and Resizing Views

To move a view, just drag it to a new location. As you drag, a black outline indicates the position 
that it will have when you release the mouse button. Use the window’s sizing handles to resize the 
view.

Combining Views

To combine (stack) any view window with another, drag the view to another view. A black box 
appears around the view you want to combine with. When you drop the view you are dragging, the 
views stack together, allowing you to switch between the two by clicking their titles.

Refreshing, Minimizing, and Maximizing Views

Click the two green arrows in a circle to refresh the view. Click the Minimize button to minimize the 
window. Click the Maximize button to expand the view to fill the entire console window. 

Popping Out a View

Drag a view outside the frame of the actual console to have the view available in its own, separate 
window. In the Monitoring perspective, you can also click the Load in external browser icon to have 
the Monitoring editor window loaded in your default Internet browser. 

Tips and Tricks

For further tips and tricks for operating the ZENworks VM Management Console, see Section A.3, 
“Tips and Tricks with the ZENworks VM Management Console,” on page 94.
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Virtual Machine Builder and Warehouse Perspective

After you close the Welcome pages, the VM Management perspective displays, as shown in the 
following figure. Click the Monitoring button in the upper right corner of the console to display the 
Monitoring perspective. 

Figure A-2   VM Management Perspective

The VM Management perspective contains the Workspace view, VM Warehouse view, and the 
Properties view on the left side of the default perspective setup. The editor view space is the large 
section to the right.

“Workspace View” on page 89
“Warehouse View” on page 90
“Properties View” on page 91
“Displaying Versions” on page 93

Workspace View

The Workspace view is used to display VMs that can be edited. You can edit the VMs in the 
Workspace. The following figure represents an example of the Workspace view.

Figure A-3   VM Management Workspace
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The Workspace provides access to the VM Builder and also lists VMs that have not been checked in 
or are in a checked-out state copied from the warehouse. You can build a new VM, edit the metadata 
attached to the VM, edit the VM image, and check in the VM to the VM Warehouse. The VMs are 
listed with the VM name and the creation or check-out date. These different states are:

Defining: Defining a VM is process of setting its parameters and constraints by adding the 
information in the VM Builder Wizard. For details on defining a VM, see Section 3.2.2, 
“Defining the Virtual Machine,” on page 42.
Defined: A defined VM has had sufficient information added in the VM Builder Wizard but 
has not been created. The VM can be defined and closed, or you can keep the wizard open to 
begin installing the VM. You can also install a defined VM by right-clicking the defined VM, 
then clicking Edit. Clicking Edit opens the VM Builder Wizard again, allowing you to click the 
Install button. For details on installing a Defined VM, see Section 3.2.3, “Installing a Defined 
Virtual Machine,” on page 49. 
Installing: A VM is installing when it is in the process of being built by the VM Builder. A 
VM in the process of being built requires that you be able to see it, with the initial installation. 
You can bring up a Virtual Network Computing (VNC) console icon to view and interact with 
its installation. You do not need a VNC connection to the VM if you are installing from an 
AutoYaST file. For details about the build process, see Section A.3, “Tips and Tricks with the 
ZENworks VM Management Console,” on page 94.
Installed: An installed VM has its build process complete and is ready to be launched to install 
any applications you need on the VM, including the Orchestrator Agent and the Monitoring 
Agent. When you are finished adding applications, you close the VM, and it is ready to be 
checked into the VM Warehouse. For details on adding applications to a newly built VM, see 
Section 3.2.5, “Installing Applications on a Virtual Machine,” on page 53.
Checked Out: When a VM is checked out of the warehouse for editing, modification, and 
application installation it is listed as Checked Out. For information on checking out and 
modifying a VM, see Section 6.3, “Modifying a Virtual Machine after Checking In,” on 
page 71. 
Checking in: A VM is checking in when it is in the process of being returned the VM 
Warehouse for the next version iteration.
Check in Failed: The check-in failed.

Warehouse View

The Warehouse view shows all checked-in VMs, their names, most recent modification, and 
operating system type. The following figure represents the VM Warehouse with some checked-in 
VMs.

Figure A-4   VM Management Warehouse View

The Warehouse gives you information on:

Name: The name of the collected group of VMs. This is the name that you gave in the VM 
Builder Wizard and is the name that shows up in the VM list in the ZENworks Orchestrator 
Console.
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Last Modified: Lists when the last version was modified and checked into the warehouse.
OS Type: Indicates the type of operating system that was installed when the VM was created.

Properties View

The Properties view displays specific information and properties of a selected VM, whether selected 
from the Workspace or Warehouse view. The property is named and its description is given in the 
Value column. The following figure represents the Properties view. 

Figure A-5   ZENworks VM Management Console Properties View

The available information for the Properties view changes depending on whether you select a VM in 
the Workspace or in the Warehouse. The properties of a VM in the Workspace section are:

Description: Contains the information about the VM that make it unique or the initial parent of 
subsequent versions. This gets much of its information from user inputs and responses in the 
VM Builder Wizard.

Architecture: The type of virtual processor selected when the VM was built.
Cloneable: Indicates whether or not the VM can be cloned, if it is a template or a single 
version.
Date:  Lists the date and time of the creation of, or last edit to, the VM.
Description: Notes the purpose and any other specifics you want to list for the VM. These 
notes apply to all versions of this VM.
Gold Master: Indicates if the VM is the Gold Master version that will be deployed by the 
Orchestrator Server for VM provisioning.
Location: Indicates whether it is stored in the warehouse.
Name: The name of the VM.
OS Type: Indicates the type of operating system that was installed when the VM was 
created.
Parent Version: Indicates which version was used to make the currently selected version 
of the VM.
Status: Displays the status or state of the VM. See “Workspace View” on page 89 for a 
list of the types.
UUID: The unique identification of this specific instance and version of the VM. The VM 
is not given a UUID until it is launched for the first time.
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Version: This indicates the current assigned version number of the VM, or the number it 
will be assigned when it is checked into the VM Warehouse.
VM Crash: This is the setting for what to do if the VM crashes. It defaults to Shutdown 
which means that if the VM crashes, it shuts down immediately. 
VM Type: The virtualization type applied to the VM: paravirtualization or full 
virtualization. For more information on the virtualization type, see “Virtualization Mode:” 
on page 44.

Disks: The disks saved as part of the initial VM configuration are stored here. This section 
changes according to what kind and how many disks are saved as part of the VM metadata. The 
following are the types of disks that your VM can have:

Hard Disk: The non-saved hard disks used as normal hard disks after the VM launches. 
Any data on these disks is lost when you shut down the VM. However, the disk size is 
maintained as part of the VM image.
CD-ROM/DVD: Gives access to any physical CD-ROM or DVD-ROM that is present on 
the VM host.
OS Disk: Lists the size of the first (and only) saved hard disk of the VM. This hard disk 
contains the installed guest operating system.

Hardware: Describes the virtualized hardware and architecture you earlier designated. 
Memory and graphics information is also included.

CPUs: The number of virtual processors you have assigned the VM.
CPU Weight: A numerical representation of the priority to access the VM host’s CPU.
Graphics: Lists the virtualized graphics card. If you have a paravirtualized guest 
operating system, this lists the card as paravirtualized, which means that the VM can 
directly access the graphics card of the host.
Memory: The range of allowable RAM the system can use while running.
VNC: Indicates if you can create a virtual network connection to the VM, allowing you to 
see and operate the VM at a graphical level.

Installation: Information about how the VM was installed, its source, and any other 
installation data.

Additional Args: Any listed additional arguments you made for the VM when you 
created it.
Auto Install File: The location of the AutoYaST file used for the installation of the VM.
Install Source: The location of the source files used to install the VM.

Misc: Any miscellaneous information about the VM, including usernames applied to the VM.
User: List the root user and any other users with access to the VM. 

Network: Lists the network connection properties and virtualized network card properties.
Domain Name: This is the name of the domain to which the VM is assigned.
Host Name: This will usually be the name of your VM or it can be a host name you have 
designated during VM creation.
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Paravirtualized: This section lists the parameters of the VM’s network card. If 
paravirtualized it is listed in this state. It defaults to Default MAC; DHCP IP Address; 
however, if a DHCP, DNS, or WINS specific property has been assigned, that information 
is displayed here.
Fully Virtualized: Lists the parameters of the network card attached to the VM, including 
whether it is fully virtualized. For more information on the statuses assigned to the 
network settings, see “Network” on page 47.

Displaying Versions

Information about the VM and its history is available by: 

Double-clicking the checked-in VM.
Right-clicking the checked-in VM and selecting Show Versions.
Clicking the Show Versions button at the top of the window.

This opens an edit window on the right of the initial structure, with the following information:

Name: The name of the VM and its versions.
UUID: The unique identification of this instance of the VM.
Description: Any information you entered when you created this VM.
Architecture: The architecture of the virtualized processor.
OS Type: The type of operating system installed on the VM.
VM Type: Indicates whether the VM is fully virtualized or paravirtualized.

Figure A-6   VM Information and Version Information in the GUI Display

A.2.3  The Monitoring Perspective
Click the Monitoring button at the top right corner of the console to access the ZENworks 
Orchestrator Monitoring Service. The Monitoring Service to allows you to monitor many elements 
of the data center in both virtual and physical machines (including the VM host machines), aiding 
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you in the overall management of your data center. You can view this information in a text or 
graphical mode. The following figure represents a sample Monitoring Service page in a graphical 
view. 

Figure A-7   ZENworks Monitoring Service Graphical View

The left pane displays the groups or clusters of physical machines and VMs you can monitor. In the 
editing pane, you see a Web page where you define the parameters of how you want to monitor the 
selected machine. You can set the metric, time constraint, and how you want the data sorted in the 
display from the drop-down boxes on the left of the edit view.

For details about the monitoring service and how to access it, see Section 6.4, “Monitoring Virtual 
Machines,” on page 74.

A.3  Tips and Tricks with the ZENworks VM 
Management Console
The following is a list of tips and tricks for the ZENworks VM Management Console. They can help 
you to maximize your work effort with the VMs in your data center:

Browser/Window Tips

Click Window > Preferences and select VM Management Server to change your VM 
Management Server URL as well the username associated with that server.
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If you want to only work with one window and not have multiple windows open when you 
switch perspectives, click Window > Preferences > General menu, then select to have the new 
perspectives open In the same window.
Click the Load in external browser button in the top right corner of the edit window to open an 
external browser to display the information in a full-sized browser window.
Click the Refresh All button at the top of the console to refresh the views and any open editor 
views. Click the individual refresh buttons to refresh the specific view or editor view.
Double-click a View or an editor tab to maximize it to a full window; double-click it to restore 
it to its previous size and layout position.

Editor Tips

Editors can be dragged within the main window to re-dock anywhere you want. They can stack 
or tile but cannot be dragged outside of the main window.
Edit views do not close automatically when switching between views. In order to avoid having 
VM Management Show Version edit views cluttering your Monitoring perspective or to avoid 
having Monitoring edit views cluttering your VM Management perspective, click Window > 
Preferences in the General menu, then select to open a new perspective In a new window. Any 
time you select one of the perspectives at the top of the console, this option allows you to open 
a new window so you can keep the VM Management and Monitoring edit views separate while 
working.
Double-click any device name in the monitored servers view to load as many Monitoring editor 
views as you want. The editor windows stack with the other editor windows that you have 
open.

Views Tips

Click Window > Show View > Progress to show the Progress view at the bottom of the VM 
Management window.
Double-click the right portion of the status bar to quickly bring up the Progress view.
Click Window > Show View > Error Log to view the Error Log view at the bottom of the VM 
Management window.
Double-click the status bar to quickly bring up the Error Log view.
Double-click a VM collection to bring up the Warehouse Editor view.
Double-click a VM in the Workspace view to bring up the wizard in edit mode.
Double-click the blank area in the Workspace view to bring up the wizard in creation mode.

Wizard Tips

To quickly move around the VM Creation Wizard, click any of the blue items in the VM 
Properties Table at the left side of the wizard.
Management Consoles for ZENworks VM Management 95



96 Novell

novdocx (en)  11 July 2008
 ZENworks Orchestrator 1.3 Virtual Machine Management Guide



B
novdocx (en)  11 July 2008
BVM Management Installation 
Sources

You have two sources from which to install Novell® ZENworks® VM Management VMs:

Section B.1, “Disk Installation Sources,” on page 97
Section B.2, “Guest Operating System Installation Sources,” on page 97

B.1  Disk Installation Sources
To install a fully virtualized machine, you need to specify an installation source that must be 
mounted in such a way that the VM recognizes it as a mounted installation source. For example, 
FTP, HTTP, and NFS.

For other installation sources to use for paravirtualized installs, the following installation sources 
can be designated to serve as virtual mount points:

A disk image, such as an ISO file accessible from the local file system of the machine 
performing the installation. For example: /install_ISOs/sles10sp2.iso
A remote storage device specified by using the Internet SCSI (iSCSI) protocol. For example: 
iscsi:iqn.2001-04.com.acme@0ac47ee2-216e-452a-a341-a12624cd0225

A remote storage device specified by using a Fibre Channel (NPIV) protocol. For example: 
npiv:210400e08b80c40f

B.2  Guest Operating System Installation 
Sources
You need to designate an installation source for a paravirtualized machine. The following is a list of 
guest operating systems and the installation sources to use for a paravirtualized installation. The 
listed sources are suggestions and examples.

Section B.2.1, “SUSE,” on page 97
Section B.2.2, “Red Hat,” on page 98
Section B.2.3, “NetWare,” on page 98
Section B.2.4, “Other Linux Installation Sources,” on page 98

B.2.1  SUSE
A remote directory containing the install files, specified by using the HTTP protocol: The 
HTTPS protocol is not supported.

http://www.domain.com/install_sources/sles10sp2/

A remote directory containing the install files, specified by using the FTP protocol:
ftp://www.domain.com/install_sources/sles10sp2/

A remote directory containing the install files, specified by using the NFS protocol:
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nfs://www.domain.com/install_sources/sles10sp2/

B.2.2  Red Hat
The NFS protocol is specified slightly differently:

nfs:www.domain.com:/install_sources/sles10sp2/

The SMB protocol is not available.

B.2.3  NetWare
A paravirtualized NetWare® operating system can be installed by using the same installation 
sources as fully virtualized VMs.

NOTE: Only Open Enterprise Server (OES) 2 and OES 2 Linux can be paravirtualized. Either can 
be fully virtualized. NetWare 6.5 and earlier must be fully virtualized. See Section B.1, “Disk 
Installation Sources,” on page 97 for instructions on fully virtualizing the guest operating system.

B.2.4  Other Linux Installation Sources
All other paravirtualized operating systems can be installed by using the same installation sources as 
fully virtualized VMs.
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CVirtual Machine Technologies and 
Actions

The following tables contain information about the different Novell® ZENworks® VM Management 
technologies, ZENworks Orchestrator provisioning adapters, and actions you can perform to and 
with a VM.

This section contains the following:

Section C.1, “Virtual Machine Technologies,” on page 99
Section C.2, “Xen Hypervisor,” on page 101
Section C.3, “VMware Server Technology,” on page 105
Section C.4, “VMware Virtual Center,” on page 109
Section C.5, “Xen VM Technology,” on page 110
Section C.6, “Virtual Machine Crash Responses,” on page 114
Section C.7, “Connecting to VMware Virtual Center,” on page 115

C.1  Virtual Machine Technologies
The following table represents the available actions using VMs with ZENworks Orchestrator.

Table C-1   VM Technologies with Host Operating System, Guest Operating System, and Provisioning Adapter

Hypervisor Host Operating System Guest Operating System ZENworks Orchestrator 
Provisioning Adapter

Xen SUSE® Linux 
Enterprise Server 
(SLES) 10

SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

xen30

SLES 10 SP 1 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP
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RHEL 4 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

RHEL 5 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

VMware Server SLES 10 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

vmserver

SLES 10 SP 1 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

RHEL 4 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

Hypervisor Host Operating System Guest Operating System ZENworks Orchestrator 
Provisioning Adapter
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C.2  Xen Hypervisor
The Xen hypervisor runs on SLES 10, SLES 10 SP 1, RHEL 4, and RHEL 5 host machines. The 
following tables represent the ZENworks Orchestrator VM actions and whether or not ZENworks 
Orchestrator can perform that action on the guest operating system. The tables are listed according 
to host operating system.

Section C.2.1, “SLES 10,” on page 102
Section C.2.2, “SLES 10 SP 1,” on page 102
Section C.2.3, “RHEL 4,” on page 103
Section C.2.4, “RHEL 5,” on page 104

RHEL 5 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

Windows Server 2003 SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

VMware Virtual Center Subject to the VMware 
support matrix

SUSE 8

SUSE 9

SUSE 10

RHEL 4

RHEL 5

Other Linux

Windows Server 2003 
Windows XP

vcenter

Hypervisor Host Operating System Guest Operating System ZENworks Orchestrator 
Provisioning Adapter
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C.2.1  SLES 10

Table C-2   ZENworks Orchestrator VM Actions Supported for SLES 10 Using Xen

C.2.2  SLES 10 SP 1

Table C-3   ZENworks Orchestrator VM Actions Supported for SLES 10 SP 1 Using Xen

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux

Provision X X X X X

Clone X X X X X

Cold Migrate X X X X X

Shutdown X X X X X

Destroy X X X X X

Suspend X X X X X

Pause

Resume

Create 
Template

X X X X X

Hot Migrate

Checkpoint X X X X X

Restore X X X X X

Install 
Orchestrator 
Agent

X X

Make 
Standalone

X X X X X

Check Status X X X X X

Personalize

Save Config

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X
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C.2.3  RHEL 4

Table C-4   ZENworks Orchestrator VM Actions Supported for RHEL 4 Using Xen

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause X X X X X X

Resume X X X X X X

Create 
Template

X X X X X X

Hot Migrate X X X X X X

Checkpoint X X X X X X

Restore X X X X X X

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
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C.2.4  RHEL 5

Table C-5   ZENworks Orchestrator VM Actions Supported for RHEL 5 Using Xen

Resume X X X X X X

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause X X X X X X

Resume X X X X X X

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
 ZENworks Orchestrator 1.3 Virtual Machine Management Guide



novdocx (en)  11 July 2008
C.3  VMware Server Technology
The VMware Server hypervisor runs on SLES 10, SLES 10 SP 1, RHEL 4, RHEL 5, and Windows 
Server 2003 host machines. The following tables represent the ZENworks Orchestrator VM actions 
and whether or not ZENworks Orchestrator can perform that action on the guest operating system. 
The tables are listed according to host operating system.

Section C.3.1, “SLES 10,” on page 105
Section C.3.2, “SLES 10 SP 1,” on page 106
Section C.3.3, “RHEL 4,” on page 107
Section C.3.4, “RHEL 5,” on page 108
Section C.3.5, “Windows,” on page 109

C.3.1  SLES 10 

Table C-6   ZENworks Orchestrator VM Actions Supported for SLES 10 Using VMware Server

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux

Provision X X X X X

Clone X X X X X

Cold Migrate X X X X X

Shutdown X X X X X

Destroy X X X X X

Suspend X X X X X

Pause

Resume

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
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C.3.2  SLES 10 SP 1

Table C-7   ZENworks Orchestrator VM Actions Supported for SLES 10 SP 1 Using VMware Server

Create 
Template

X X X X X

Hot Migrate

Checkpoint X X X X X

Restore X X X X X

Install 
Orchestrator 
Agent

X X

Make 
Standalone

X X X X X

Check Status X X X X X

Personalize

Save Config

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause

Resume

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux
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C.3.3  RHEL 4

Table C-8   ZENworks Orchestrator VM Actions Supported for RHEL 4 Using VMware Server

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause

Resume

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
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C.3.4  RHEL 5

Table C-9   ZENworks Orchestrator VM Actions Supported for RHEL 5 Using VMware Server

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause

Resume

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
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C.3.5  Windows

Table C-10   ZENworks Orchestrator VM Actions Supported for Windows Using VMware Server

C.4  VMware Virtual Center
The VMware Virtual Center hypervisor runs on SLES 10, SLES 10 SP 1, RHEL 4, RHEL 5, and 
Windows Server 2003 host machines. The following tables represent the ZENworks Orchestrator 
VM actions and whether or not ZENworks Orchestrator can perform that action on the guest 
operating system. The tables are listed according to host operating system.

NOTE: Host operating systems are dependant on the VMware Virtual Center support matrix.

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause

Resume

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

Install 
Orchestrator 
Agent

X X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X
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Table C-11   ZENworks Orchestrator VM Actions Supported Guest Operating Systems Using VMware Server

C.5  Xen VM Technology
The following sections represent Xen VM technologies.

Section C.5.1, “SLES 10,” on page 111
Section C.5.2, “SLES 10 SP 1,” on page 111
Section C.5.3, “RHEL 4,” on page 112
Section C.5.4, “RHEL 5,” on page 113

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 8 SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X X

Clone X X X X X X X

Cold 
Migrate

X X X X X X X

Shutdown X X X X X X X

Destroy X X X X X X X

Suspend X X X X X X X

Pause

Resume

Create 
Template

X X X X X X X

Hot Migrate X X X X X X X

Checkpoint X X X X X X X

Restore X X X X X X X

Install 
Orchestrator 
Agent

X X X X X X X

Make 
Standalone

X X X X X X X

Check 
Status

X X X X X X X

Personalize X X X X X X

Save Config X X X X X X X
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C.5.1  SLES 10

Table C-12   ZENworks Orchestrator VM Actions Supported for SLES 10 Using Xen

C.5.2  SLES 10 SP 1

Table C-13   ZENworks Orchestrator VM Actions Supported for SLES 10 SP 1 Using Xen

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux

Provision X X X X X

Clone X X X X X

Cold Migrate X X X X X

Shutdown X X X X X

Destroy X X X X X

Suspend X X X X X

Pause

Resume

Create 
Template

X X X X X

Hot Migrate

Checkpoint X X X X X

Restore X X X X X

Install 
Orchestrator 
Agent

X X

Make 
Standalone

X X X X X

Check Status X X X X X

Personalize

Save Config

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X
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C.5.3  RHEL 4

Table C-14   ZENworks Orchestrator VM Actions Supported for RHEL 4 Using Xen

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause X X X X X X

Resume X X X X X X

Create 
Template

X X X X X X

Hot Migrate X X X X X X

Checkpoint X X X X X X

Restore X X X X X X

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
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C.5.4  RHEL 5

Table C-15   ZENworks Orchestrator VM Actions Supported for RHEL 5 Using Xen

Resume X X X X X X

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows

Provision X X X X X X

Clone X X X X X X

Cold Migrate X X X X X X

Shutdown X X X X X X

Destroy X X X X X X

Suspend X X X X X X

Pause X X X X X X

Resume X X X X X X

Create 
Template

X X X X X X

Hot Migrate

Checkpoint X X X X X X

Restore X X X X X X

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
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C.6  Virtual Machine Crash Responses
When you design a VM with the VM Builder, the VM crash direction is by default set to shut down 
the VM. However, after you have built and installed the VM, you can change its crash directions to 
any of the following options:

Table C-16   VM Crash Directions

Install 
Orchestrator 
Agent

X X X X X

Make 
Standalone

X X X X X X

Check Status X X X X X X

Personalize X X X X X

Save Config X X X X X X

Direction Explanation

Shut down If the VM crashes, the host operating system alerts 
the administrator and shuts down the VM. It 
remains in its shut-down state until it is restarted by 
the administrator.

Save core dump; then shut down If the VM crashes, the host operating system saves 
the core dump, alerts the administrator, and shuts 
down the VM. It remains in its shut-down state until 
it is restarted by the administrator.

Restart If the VM crashes, the host operating system alerts 
the administrator and the VM automatically restarts.

Save core dump; then restart If the VM crashes, the host operating system alerts 
the administrator, saves the core dump, and the VM 
automatically restarts.

Preserve the image as is If the VM crashes, the host operating system alerts 
the administrator and preserves the image in its 
crashed state until the administrator decides the 
next course of action.

Rename; then restart If the VM crashes, the host operating system alerts 
the administrator, renames the image, then restarts 
the renamed image.

ZENworks 
Orchestrator 
Managed VM 
Action

SUSE 9 SUSE 10 RHEL 4 RHEL 5 Other Linux Windows
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C.7  Connecting to VMware Virtual Center
1 Make sure that the Windows Orchestrator Agent is installed and started on the Windows host 

running Virtual Center.
2 Make sure that J2RE with version 1.4.2 for VCenter 1.x or version 1.5 for VCenter 2.x is 

installed on the Windows system running Virtual Center.
The JREs that ship with Virtual Center and with the Novell Agent are version 1.5. Version 
1.4.2_15 can be downloaded from the Sun* Download Center (https://sdlc4a.sun.com/ECom/
EComActionServlet;jsessionid=88B0E4E7E868F2F6C671427ACC9C0D13).

3 On the server where Virtual Center is installed, find the rui.crt certificate.
On Windows, the default location is: C:\Documents and Settings\All 
Users\Application Data\VMware\VMware VirtualCenter\SSL\rui.crt.

4 Create a VCenter_Certs directory at the top level by entering mkdir 
C:\VCenter_Certs\.

5 Copy rui.crt to C:\VCenter_Certs\.
6 Run keytool.

The default location is C:\Program Files\VMware\VMware VirtualCenter 
2.0\jre\bin\keytool.exe.

7 Enter:

cd C:\VCenter_Certs

[path]keytool -import -keystore keystore -file rui.crt

8 Enter a password when prompted.
9 In ZENworks Orchestrator Console, edit the vcenter policy by entering the URL, username, 

and password.
10 In the ZENworks Orchestrator Console, edit the vcenter_client policy to do the following:

Set keystore to point to C:\VCenter_Certs\keystore.
Set the Java JRE path.

11 Save the changes.
12 Drag and drop the vcenter and vcenter_client policies to the server where Virtual Center is 

running.
13 Discover VM hosts.
14 Discover VM images.
15 If the VM images are not listed in the tree, restart the ZENworks Orchestrator Console.

NOTE: VM host discovery on the vcenter adapter can fail because VM host discovery with Virtual 
Center requires JRE 1.4.2 for VCenter 1.x and JRE 1.5 for VCenter 2.x to be installed on the 
Windows-based Virtual Center host. The JRE that ships with the Orchestrator Agent and with 
VMware Virtual Center is JRE 1.5.
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DSample VM Management Jobs

This section provides a sample job that can be run in the Novell® ZENworks® Orchestrator Console 
to aid you in managing your VMs in your data center:

Section D.1, “Installing the ZENworks Orchestrator Agent on an Apache Virtual Machine,” on 
page 117

To develop your own jobs to manage, provision, and control your VMs in your data center, see the 
sample job or refer to “Virtual Machine Job Development” in the Novell ZENworks Orchestrator 
1.3 Developer Guide and Reference.

D.1  Installing the ZENworks Orchestrator Agent 
on an Apache Virtual Machine
This job is designed to help you to install the Orchestrator Agent on all VMs running Apache. You 
can cut and paste this job into your ZENworks Orchestrator Console or you can use this job as a 
template from which to make new jobs.

"""

Search for a VM Grid objects using Constraints and
run a VM operation on them.

"""

class test(Job):

     def job_started_event(self):

        # collect all VM Instances whose resource ID
        # starts with the string "apache"

        a = AndConstraint()

        e1 = EqConstraint()
        e1.setFact("resource.type")
        e1.setValue("VM")
        a.add(e1)

        e2 = EqConstraint()
        e2.setValue("apache*")
        e2.setMatchMode(EqConstraint.MATCH_MODE_REGEXP)
        e2.setFact("resource.id")
        a.add(e2)

        vms = getMatrix().getGridObjects(TYPE_RESOURCE,a,None)
        for vm in vms:
            vm.installAgent()
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